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Preface

This module contains information that about the features and components of Informatica ActiveVOS. This
module contains information about the Business Process Execution Language (BPEL) that ActiveVOS and a
tutorial.
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Process Developer Components

Process Developer includes the following components:

¢ Process Developer
The Process Developer lets you create, simulate, deploy, and execute BPEL processes.

e Orchestration Project Samples
The Process Developer tutorial and other orchestration samples contain files to get you started on basic
and special processes.

¢ Ant Runtime for Command Line Execution of Deployment and Testing Scripts
The installation wizard allows you to select the BUnit Runtime to install the Eclipse plugins necessary to
run Process Developer scripts outside of Process Developer. These scripts include BPRD and BUnit Ant
files. BPRD scripts include targets for deployments to the process Server. BUnit scripts include targets for
unit testing your BPEL processes.



Process Developer Feature Tour

Process Developer offers the following features:

Simultaneously
displayed diagrammatic
and hierarchical view of
process

Create a process diagrammatically on the canvas. Use the synchronized Outline view to
see a hierarchical element structure of the process.

Source view is also available to view BPEL code that Process Developer generates.

Process Editor canvas
styles

Select BPMN-centric, BPEL-centric BPMN, or Classic styles for modeling notation. Drag
and drop icons onto a canvas to create a process. Process Developer creates valid BPEL
code and generates a task list for missing and invalid activity properties.

Participants and
interfaces

Catalog your business partners and WSDL and schema files in your project for automatic
discovery and organization of all pertinent information stored in existing WSDL files.
Comprehensive searching is available to locate namespaces, messages, and other
elements. Use drag and drop operations to the Process Editor canvas for automated
activity creation.

Management of sample
data

Add sample data files for all WSDL messages for a convenient registry of test data across
all processes using the messages. Add multiple files for various test scenarios.
Automatically generate sample data for complex types. During simulation, test various
execution paths using different data.

Automatic static
analysis

Process Developer generates a problem list for all incomplete or invalid BPEL constructs
so that you can fix problems without hunting for them. This feature works on imported
BPEL files as well as native BPEL 1.1 and 2.0 files.

Build a process by
creating the
participants

Specify the process consumer and partner service roles for the process and then fill in the
Web Service interaction activity details.

Unit testing

Comprehensive BUnit Editor and debugging environment for unit-testing process inputs
and outputs.

Automatic variable
assignment

Create Copy Operations automatically for new or existing Assign activities. Drag the Copy
FROM variable to the Copy TO variable. Icons and colors indicate at a glance how a
variable is used.

Expression and query
builders

Process Developer gives you visual expression editing controls for building a wide range
of scripts. In addition, you can readily extend the Process Developer expression editor to
include your own expression language and custom functions. Built-in BPEL functions are
automatically added to expressions.

Activity properties

Required and optional activity attributes are grouped for easy selection in the Properties
view. Pertinent selections are in picklists. Add comments. Add correlation properties,
compensation, and fault handling. Link to property definitions, such as WSDL operation.

Create reusuable BPEL
components to re-use a
selection of activities in
other processes

Select one or more activities on the Process Editor canvas and save them to the Custom
Palette for later use. Significantly shorten design time by reusing modular elements.

Process Developer Feature Tour

7



Simulation and
debugging

Simulate process execution using sample data. Set breakpoints, step through, or run the
process. Remotely debug a process running on the server and suspend a process on an
uncaught fault to perform exception management.

Process deployment

Deployment wizards help you provide endpoint references and policy assertions for
services used in your process. A process deployment descriptor provides error-free
techniques for binding your services.

Processes are automatically deployed to the appropriate server location within a package
that contains all required files. The files become a contribution unit on the server and are
managed as a unit.

You may also want to use the Process Developer tutorial to explore basic Process Developer concepts.

XML Syntax

The following table lists XML symbols and their meaning for Business Process Execution Language (BPEL)
XML syntax. The symbols indicate the allowable code according to the BPEL schema.

8

Symbol | Meaning Example

+ One or more of this element is allowed | <correlation set="ncname" initiate="yes|no"?>+

? Zero or one element is allowed abstractProcess="yes|no"?

* Zero or many of this element is allowed | <onAlarm (for=duration-expr | until="deadline-
expr")>*
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Tips and Tricks

Create an Orchestration Project to hold all resources

An orchestration project contains a collection of folders that Process Developer uses to build processes. Builders and
validators make sure you're on the right track as you create processes.

Start with a Process Developer Sample project.

B New Orchestration Project uﬂlﬂ

New Orchestration Project from Template —

Opticnally choose a Project Template to use as the starting point for your new
Orchestration Project.

Create an Orchestration Project using one of the templates
Available Templates:

4 [= Process Developer The Orchestration nature is enabled,
(2 Default Orchestration including builders anfi validators for BPEL
2 Java Enabled Orchestration processes and W5DL interfaces.

4 [= Process Developer Samples
2 Tutorial

2 Tutorial Completed

@ Next > Finish | [ Cancel

Jump Start a new BPEL process with service references and participants
Add a WSDL file to service references or directly to an orchestration project before creating BPEL activities.
Process Developer catalogs WSDL files for automated activity creation.

B

[D Projeck Explorer i3

B =
i @ Service References
#- (== bpel
#-[= deplay
[== Farm
[ [ Partner_Services
*- = sample-data
#- = scherma
[ test
= wsdl
e |

e

Tips and Tricks 9
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Participants

Define the Web services that use the process and the partner services that the process uses. This is a fast and
intuitive way to start a process.

@ Participants 23 () Process Variables g
=1 Process Service Consumers
=1 lnanProcessar

= . requesk

=t &

B

] ] Input: creditInformationMessage

&

‘] Cutput: approvalMessage

]

] Fault: unableToHandleRequest: errorMessage
=8 |? Partner Service Providers

= |_3' RiskAssessment

= o check

o

3 ] Input: creditInformationMessage

] Cutput: riskAssessmentResponse

2]

#- | Fault; loanProcessFaulk: errorMessage
2 ® Loanapproval

= W approve

el

] Input; creditnformationMessage

-

] Cutput: approvalMessage

23]

‘] Fault; loanProcessFault: errorMessage

$ Hurman Task Participants

Create activities for participants
Drag a participant's operation to the Process Editor canvas to create activities.
Activities are contained within a sequence, so that adding new activities in sequence is easy.

_:' request

Feply

Create message properties and property aliases

Message properties are WSDL extensions for BPEL that allow you to correlate messages for a long-running,
asynchronous process. Select Add Correlation Set to create message properties and property aliases.

Chapter 1:
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+- 9 Imports

- 4> Namespaces

E

! Process T
/5 Fault Handlers

i

; Add Correlation Set...

After you create message properties and property aliases, they are added to process variables and WSDL files.

Next, you will create correlation sets, adding them to each activity that should correlate messages.

| et [stirg)

=22 -

(%) CuslonmertaimeRequest x .[‘.HPm-iectE;;Db'cl % 3 =t
= ardns:CostomerhameR=nuest = @ CRM-Onder Sanden wsdl

%, customerdD [strng] =+ LastOroerRecuestiyD
- ¥, propertes [0 [ Lastorcerkacuest

|= | CustomeriameRequest
= CostomerlameRespons=
=-|2 cAM ardeHandier
=4 SCAPTInCing

+ CRM-Chale Henller

2| OrderTd [Tustome N eRequast)
£| Orderld [CustomerMam eRespons:

Use the convenient repository of sample data with automatic generation for complex types

After entering Variables View, right-mouse click on a message part to generate or add sample data, instance
documents for a complex type, or values for a simple type. For a complex part, Generate Sample automatically.

Data is automatically loaded into process variables when you are simulating process execution.

Data can be reused with other processes.

(x) creditinfarmation
g O H——
El {) loanProcessRequest
A loanType
( ) firstMame
A D lastMame
£ % davPhone
£ % nightPhone
( ) socialSecurityMumber
oAl amountRequested
£ % loanDescription

£ % responseEmai

| Data

Auko
James
Jones
561
Q99

054871854

2001

w |

Tips and Tricks
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Manually add a target namespace or other imports to a BPEL process
If you start a process with an operation, the target namespace is automatically added.
Manually add a target namespace in the Outline view by right-mouse clicking Imports and selecting Add Import.

) WSsDL/loanServicePT|
&3 Namespaces
27 partner Links
() Variables

B8

Process Activities
U Fault Handlers

-8

“|| Correlation Sets
5 Event Handlers

Customize process settings

Process Developer has extensive settings for globally customizing BPEL processes. Set preferences for all processes,

such as suppressing join failures and providing a default target namespace. Override the defaults for individual

processes as needed.

@ Preferences
!type filker best

- General
=]

Colors and Fonts
Custom Functions
Identity Chooser
Layout
Remote Debug
Simulation
Tasks and Problems
- Ant
[+~ Busingss Process
[#- Data Management
[#-Help
- Install/lpdate
[#-Java
- Jawascript
JPA
[ Model Yalidation
[ Plug-in Development
¥ Report Design
[#- RunfDebug
[+ Server
Service Policies
- Team
Walidation
B Web
- Wweb Services
[ ¥Doclket
- KM

ActiveVDS ix -

Define new process defaults and object add option.
Hew BPEL Process Defaults
Target Namespace preamble:
| htepiff |
({e.q., http:/funmw, wourcompany . com/process))
Expression Language {URI):

Suppress Join Failure
[] abstract Pracess

=
BPEL Wersion: |WS-BPEL 2.0 |+

BPEL 2.0 Extensions

Create ¥Path
Disable Selection Failure
Lirks are Transitions

Add Object Option

Launch primary property dislog after add

Mew Deployment Options

Addressing Yersion: | W3C Addressing 1.0 (200508} v}
Restore Defaults apply

Create variable assignments automatically

Drag a like-typed process variable or variable part onto another process variable to automatically create a Copy
operation. Blue color and from and to arrows differentiate variable parts.

Chapter 1:
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FROM variable part TO variable part f
() request |() BuyerPo
= loandef:creditinformationMessage| = || nsl:acceptPO
%} amount [integer] =~ @} parameters [purchaseOrders]
4%} name [string] = €» purchaseOrders*
%) firstName [string] =€ purchaseOrder... [Purcha
@ orderDate [date]
=-£ ¥ shipTo* [USAddress]
@ country [NMTOK

O

Process viewing tips
Collapsing Containers

Manage screen real estate by collapsing containers like scopes, whiles, and sequences. Double-click to view the
expanded activity in a drill-down window.

Make any activity horizontal or vertical.

MewProcess == SCope

() —

request Feply

Thumbnail View
Use Thumbnail view to select and pan a section of the process.
To display the Thumbnail view, select Window > Show View > Thumbnail

mrec
A

%il VTS
* BAS

.’;'lb'CDpE
1
EAEL [ [w]

—_—
5 Scop [P O
alfivO 1

Viewing full screen
View a process full screen by double-clicking the process's title bar.

To view process properties and to activate the main toolbar, click anywhere on the Process Editor canvas to put it in
focus.

Tips and Tricks
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NewBPELProcess.bpel . \

Significantly shorten design time with BPELets

Save any BPEL activity or set of activities as a BPELet-a custom activity. Drag a BPELet from the Custom palette to the
canvas for any process.

E Customize Palette §|

¥, % + it (£ Receive-Tnvoke-Reply
New Delete Move Down [Hove Up AT

it StahFJard L | Receive-Invoke-Rephy

+ Activity o

+-  Container Description:

+- Drawing BPELet to get customer Id
. BPELets and set customer name

LM Receive-Invoke-Reply [ Hide

& AssignliteraltoAddrl

QK | Cancel Apply

Discover and fix problems with automatic validation
View a list of errors, warnings, and information for invalid activities. Correct the problem, and it automatically

disappears.
=l Praperties | {5, Prablems 22 o Relationships | 47 Servers @] Error Log | &
3 errars, 0 warﬁings, 1 other ] ) - )
Description = Resource Path Location Type
= @ Errors (3 items)
@ Missing value For required Field - operat tutorial.bpel  frutarial Activity: [... BPEL
@ Missing value For required Field - partne tutorial.bpel  ftutorial Activity: [... BPEL
@ Mo activity designated to create instan butorial.bpel  ftutorial Process: [t... BPEL
i Infosi1 item)

Activity creation tips

Add a link between activities by selecting the source activity and then selecting the target. Select Link Activities from
the right mouse menu or use the toolbar Edge icon.

14 Chapter 1: Resources



Contain a group of activities in a container by selecting them and then right mouse clicking on Create Container.

c Receive

@ Link Activities

™ cotc Contaner [
of Cut {0 For Each

\_ & copy £ Repeat Until
[B Paste (©) scope
¥ Delete > Sequence
< Undo Creating Node & whie
% Redo [

Add data mappings in activities like Receives and Replies. Alternately, add an Assign then add/edit copy operations in
the Assign by double-clicking the activity or by selecting from the right mouse menu of the activity.

Edit Copy Cperations...

Add fault handling (or other handlers) to a scope by dragging a catch to a scope from the palette.
Note that a fault activity is added to a catch container.
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) (A )catch

L __l
& | o

Process design tips

Use Auto Layout on any container, such as a While or If activity, to optimize your display area. You can also select a
group of objects for auto layout.

Objects snap to a grid. Move an object one pixel at a time by using the Alt key + mouse combination.

: ;
&) - |

Add r
@ Link...

a ¥ | () Edt conditon...

<& Auto Layout

—=| Collapse Container
Create Container 4

f\‘j Break

Activity names can be long and descriptive.

' ‘% Invoke a Web
Service ko

request a quate

Use the comprehensive simulation, unit testing, and remote debugging capabilities

Simulate execution of a process by generating sample data values for the messages and stepping thorough various
execution paths. Process Developer's internal execution engine provides runtime behavior for testing purposes.
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Save a simulation as a BUnit test.
Rerun all or only failed BUnit tests or

suites .t0 Venfy normal process Re;:;ive Cuskomet Request For Loan Amount
execution.

£, Invake Risk

Assessor

v

large Ioanlor review risk ™

Iowlrisk high risk.
Invoke Loan ¥
Approval
Approve Deny

Return Approval Response

%5 Debug 1 . _99 Breakpoints | 0= outline | = O

-
%
|Save Simulation as BUnik Test Casei

zkerminated = Simulate Pro
: ﬁ <terminated = tukarial [1]

£ ﬁiﬁ <terminated > Activel DS Enterprise Serds

< | >

Easily find the declarations, types and data files in your workspace by using the various Open dialogs on the Navigate
menu.
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E Open Operation

Enter operation name critieria: -

ia* |

Makching items:

. activate

o ackivate

) addattachment
. addCammenk
. approve

. approve

o askieight

b

. authorize

http:/fdocs. active-endpoin. .. [2008/02 /loanspproval wsdl

7 [ Ik l [ Cancel

Starting the Process Server from within Process Developer (On-Premises Only)
For remotely debugging your processes, start the server engine, and complete the deployment steps.
View the Process Console by typing the console URL in your browser.

Start the server:

- Select the Servers view in the lower right of the workspace.

- Right-click and select New > Server. Select the Process Server and click
Finish.

- Select the Start the Server button. As the server starts up, you see start up
tasks scroll in the Process Console. Files are deployed to the embedded
server each time you start it.

View the Process Console by selecting the Process Console toolbar button. A
browser opens with the following URL:

http://localhost:8080/activevos

Change to a different port if this one is already in use on your computer.

Business Process Model and Notation (BPMN) is a graph-oriented notation standard favored by business
analysts and designers to model the flow of activities for analysis, documentation, and execution. Process
Developer uses this standard by default for designing executable BPEL processes.

Organize High Level and Detailed Views of a Process
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Organize your process into units of work, represented by scopes. A scope is a container for any number of
activities and control flows. Collapse the scopes, using a right-mouse menu item. Collapsed scopes create a
high-level view of a process, as the example shows.

Receive Check Inventory Confirm Order
Custarmer Crder . e Shiprnent
_& [+ _[H

Select the plus sign (+) or the right-mouse menu option, Go Into Activity, to view the activities contained in
the scope, as shown below. Select the navigation trail at the top of the window to return to the full view of the
process.

OrdetProcessafrer == Receiwe Customer Order

(/| Cateh BadorderError

_ A Icatch Al
(@) e

ReceiveCustomerOrder p S

( \ ¥

RepIyWithOrderErrorTnCustomer

¥

Suspend

¥
@ SuspendonBad

ThrowBadCrderError Order

Select Horizontal or Vertical Layout
Select the layout suitable for your process and individual activities in the process.

If activities are contained, for example inside a sequence, the parent container sets the layout. If activities are
connected with links, you can select a different layout for each connected activity. In the example below, the
horizontal sequence containing three activities is linked to a vertically aligned activity.
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If Condition

| ; l

Receive 4
Else

Reply

||| Faor Each

Use Structured Control Flows
Take advantage of the structure built into activities.

The if, pick, and fork join activities are each pre-built with two paths, as shown in the example. You can add
more paths or delete existing paths as desired. For example, execute several activities in parallel by adding
multiple paths to the fork join.
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If

,:_ ; Pick.

If Zondition Else On Message On Alarm

HQ._

.

Add Activities to a Path of If, Pick, Fork Join

Drag any activity from the palette to the implicit sequence, as shown by the blue border in the fork join
example. Each new activity you add to a path is in sequence, as shown on the right-hand path.

Add End Events to Paths of If, Pick, Fork Join

If no activities follow a fork join, if, or pick, you can remove the merge diamond by adding end events, as
shown in the fork join example.

BPMN Design Hints
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Add and Delete a Path of If, Pick, Fork Join

Use the right-mouse menu to add or delete a path, as shown in the fork join example.
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[ 7]

] Emnpky ] Emnpky

+

. . | M
-

@ Link...

-'fg Suko Layouk
E{> Make Horizontal

of Cut

Double-click to Add Expressions and Conditions

Quickly add a condition to an if, while, or repeat until by double-clicking on the activity label. The appropriate
builder opens. Double-click also opens an assign activity and the transition builder for a link.

Use Boundary Events for a Streamline View of Event Handling

You can create an uncluttered view of process events by using boundary events instead of normal scope
handlers.

In the following example, you see in the top picture a scope with a catch and an onEvent handler. The
onEvent throws a fault to the catch to cancel a loan application. In the bottom picture, the same events occur
by using an interrupting onEvent which links to the cancellation work.

The bottom picture is easier to understand. Note that interrupting onEvent and onAlarm events are
Informatica Business Process Manager extensions to WS-BPEL 2.0

Figure 1: Scope with normal catch and event handlers:
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-

Receive Loan Application

Cu:unfirmfeceipt

| A :' Catch

|

s . l

Perform Cancellation
Throw

Mokify Customer

I ] i
'H J'Cancel Application

- [] Dovwork |

.

% Makify Cuskomer
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Receive Loan Application

-

Confirm Receipk

Process Loan L Perform
=) ————» Cancellation

& iZancel Application

. Motify Customer
>

Mokify Customer

More examples

Here are some notes on BPMN Usage

A none intermediate event is traditionally used to note a milestone in the process. For example, the quote
request is now in progress. At such a milestone, it is common that someone would want to be able to
assign to a status variable. Thus an intermediate none event labeled in progress would, under the covers,

assign the string in progress to the status variable. Alternately, a none intermediate event can be
implemented as an empty.

Drag a message catch event to a boundary of a bordered activity and it becomes an OnEvent event
handler. Drag it to an event-based gateway and it becomes an OnMessage. Drag it anywhere else and it
becomes a receive. A message catch event is a waiting event, waiting for something to trigger it.

BPMN Design Hints 25



Event-Based Gateway (Pick)

(e
o
Timer P
Messagn_e_';atch Event : ! J
l:.l: ‘:]:I
Messag':e Throw Event Jv
: I s ] 1
_:.t‘-:i::"l [
- Ifitermediate _ n\ =

Message Catch Event

Ehree implementations of Message Catch Event

e Drag a message throw event to the canvas and select the implementation desired: invoke, people, or reply.
A message throw event is an outbound event, generating an event.

Message Catch Event .-Three implementations of Message Throw Event

Message Throw Event Lmi;nkai"

—
(=)
L

Message Throw Exent I:F'!,?-‘E;D|E ackivity)

Message Throw Event (Reply)
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Glossary

.bpel. BPEL file extension.

.bpr. Business process archive file extension.

.bprd. Business process archive descriptor script file extension.
.bunit. BPEL Unit testing file.

.pdd. Process deployment descriptor file extension.
.pdef. Partner definition file extension.

.tfrm. Task presentation form.

.vbpel. Visual BPEL file extension.

.wsdl. Web services description language file extension.
.xds. XML schema file extension.

.xml. XML data file extension.

abstract process. A business protocol description document that tells your business partners what a process
will look like when it runs. It outlines the steps of process without actually filling in all the actions and data
required for a running process. See Executable Process.

activity. A processing step; for example, a Receive activity accepts an input variable and can pass it to the
next activity.

All. Attribute information item. Part of an XML Infoset.
BPEL. Business Process Execution Language.

BPEL Process. A composition of partners, services and operations, and a definition of how data flows among
those entities.

BPELVariableName. Name of a variable. Derived from XML Schema NCName.
CIl. Character information item. Part of an XML Infoset.

connection pool. As a requestor application opens a connection to a data source and then releases it, the
connection remains open for reuse by another requestor. In this way, a pool of open connections is built, with
complete authentication information and connection properties. If available, the connection requests to the
same data source are satisfied from the pool rather than by making a hard connection on demand, which
enhances performance of the requests.

container. A structured activity that sets rules and conditions for executing child activities; for example, a
sequence organizes activities to execute in an ordered list.

deadline or duration. The settings for OnAlarm events in a pick activity, event handler, or task.
DIl. Document information item. Part of an XML Infoset.
Ell. Element information item. Part of an XML Infoset.

executable process. A BPEL process that contains all the actual message data, operations, and partner
information required for a running process. It uses the full power of data assignment and selection. See
Abstract Process.

join condition. A Boolean expression indicating the status of a link targeting an activity.

my role. A child element of a partner link. A partner link defines "my role" as the role played by the business
process. The service called for receive, pick and event input messages is the service fulfilling my role.
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partner. A unique collection of partner links.

partner link. Describes the roles that a process and service play as well as what data they can manipulate in
that role. A partner link is defined by its partner link type.

partner link type. Describes the kind of message exchange that two WSDL services intend to carry out. A
partner link type characterizes this exchange by defining the roles played by each service and by specifying
the port type provided by the service to receive messages appropriate to the exchange.

partner role. A child element of a partner link. A partner link defines partner role as the role played by an
invoked service.

TII. Text information item. A sequence of zero or more Character Information Items, according to document
order; as such, a Tll is not manifested in and of itself directly in XML serialization. When mapped to the XPath
1.0 model, it generalizes a string object (which has zero or more characters) and text node.

URL. A web site address, such as http://www.informatica.com.
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CHAPTER 2

Introducing Business Process
Execution Language

Business Process Execution Language for Web Services (BPEL) is an XML notation for defining process
orchestrations based on Web services protocols. The BPEL specification is an important standard in the Web
service architecture. It describes process-specific language constructs and defines how multiple Web
services can be composed into coherent information systems. BPEL builds upon other standards in the Web
services architecture, most notably Web Services Description Language (WSDL).

BPEL Resources

The WS-BPEL 2.0 specification is available on the Informatica Web site. WS-BPEL depends on the following
XML-based specifications:

e Web Services Description Language Version 1.1.
e XPath expression language
e XML Schema WS Addressing.

e See the WS-Addressing specification at the Web site of any of the specification's contributors, including
IBM, BEA Systems, and Microsoft.

BPEL for People Extension to WS-BPEL 2.0

Business Process Execution Language for Web Services (BPEL) is an XML notation for defining process
orchestrations based on Web services protocols. The BPEL specification is an important standard in the Web
service architecture. It describes process-specific language constructs and defines how multiple Web
services can be composed into coherent information systems. BPEL builds upon other standards in the Web
services architecture, most notably Web Services Description Language (WSDL).

The BPEL for People plugin installs extension elements described in the Web Services Human Task (WS-HT)
Version 1.0 Specification and an extension activity, called the People activity, described in the WS-BPEL
Extension for People Version 1.0 Specification. The tasks, notifications, Logical People Groups, and People
activity introduce human workflow into a BPEL process when a process activity requires human decision-
making.

For details, see Human Tasks, which is also within this help.
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What is a BPEL Process

A BPEL process is a collection of Web services whose interactions are choreographed in a defined manner.
Each service is a participant that performs some type of processing. Services can be highly granular (for
example, calculate a rate) or very large in scope (for example, process an order).

In the following figure, the process is the Seller participant, accepting a purchase order from a customer
through a Web service input message. The Seller then places the order with the Purchasing participant. To
end the process, the process returns an acknowledgement to the customer if the order was fulfilled.

~
BPEL Process

f//{"\f_el;\ Rec-eive
| service || o—— -
\ request //

=
N x g Place | ', "ﬂ"{‘?h'. =i
— c% " Order [ service || —*| ‘w
+——— \\request /| « | &
/ 3
5
a

@

Reply

After participants send the acknowledgement, they could send other messages to the customer, such as
shipping notices and invoices.

Because you want to have this type of interaction with the customer for many purchase orders, as well as

with other customers, you build one business process, and it acts as a template for business process
instances.

The business process you build has a setting to "create an instance" so that each time a new purchase order
arrives, a new process is created. The new process handles all the related interactions for it, keeping
interactions separated for each purchase order for each buyer.

The BPEL process definition uses as input the definitions from Web Services Description Language (WSDL)
files. These files contain interface information that can be shared with the outside world. A process

developer selects information such as partner link types and operations to define the process steps, as
shown in the following illustration.
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BPEL

Seller's WSDL File

<operation>
<partnerLinkType>

Supplier's WSDL File

<operation>

<partnerLinkType>

A BPEL process coordinates these interactions and composes them into a straight-through or long-running
flow. For example, if an exception occurs while a process is executing, activities could be reversed or undone,
and a BPEL process provides the techniques for correlation, compensation, and fault and event handling.

Receive PO_ Checklnventory_Reply
BPEL Process

Receive PO

Check Inventory

Reply with Acknowledgement

Process Definition Elements

The main sections of a Business Process Execution Language (BPEL) definition are shown in the following

code sample.

<process>

<!-- Definition of roles of process participants -->
<partnerLinks> ... </partnerLinks>

<!-- Data and state variables used within the process -->
<variables> ... </variables>

<!-- Correlation comment -->

<correlationSets> ... </correlationSets>

<!-- Exception management -->

<faultHandlers> ... </faultHandlers>

<!-- Message and timeout event handler -->
<eventHandlers> ... </eventHandlers>

<!-- Processing steps -->
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activities*
</process>

Informatica Extensions to WS-BPEL 2.0

32

In addition to fully supporting the WS-BPEL 2.0 specification, Informatica Business Process Manager has the
BPEL extensions described in this topic.

Process Level Extensions

e Compensation handler and termination handler
For details, see "Process Element and Properties” in this help.

The extension namespace is http://www.activebpel.org/2006/09/bpel/extension/

process coordination.

e Query handling including Create XPath and Disable Selection Failure
For details, see "Process Element and Properties" in this help.

The extension namespace is http://www.activebpel.org/2006/09/bpel/extension/query handling
Activities
The extension activities are "Suspend", "Break", and "Continue", which are described elsewhere in this help.
The extension namespace is http://www.activebpel.org/2006/09/bpel/extension/activity
Links

Links are used in WS-BPEL as synchronization constructs where one activity can be either a target or a
source of another activity, but not both at the same time. The link extension allows loop-back functionality.
See "Extension for Links" elsewhere in this help.

The extension namespace is http://www.activebpel.org/2009/06/bpel/extension/links

Custom XPath Functions

There are several custom functions, as described in "Using the Expression Builder" in this help.

The extension prefix abx is for the namespace http://www.activebpel.org/2006/09/bpel/extension.
Implicit Scopes Variables

To allow for a streamlined visual display of a process, Process Server can eliminate assign activities and
process variables used to map data. Instead, you can add data mapping within receives, replies, invokes, and
people activities. When you map data within these activities, internally scoped variables are added to contain
the data. See "Input Variable" and "Output Variable" elsewhere in this help.

The extension namespace is http://www.activebpel.org/2009/02/bpel/extension/ignorable
Interrupting Boundary Events in BPMN

You can treat event handlers as BPMN boundary events and set them to terminate the main activity. See
"Adding Boundary Events" elsewhere in this help.

The extension namespace is http://www.activebpel.org/2009/02/bpel/extension/ignorable
Undeclared SOAP Fault (Java Name)

Informatica Business Process Manager includes custom functions to catch undeclared faults and allows you
to catch a fault by Java name. For details, see "Catching Undeclared and SOAP Faults" elsewhere in this help.
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The required extension namespace is http://www.active-endpoints.com/2004/06/bpel/extensions/.
Process Server also uses this namespace to catch system errors.
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CHAPTER 3

ActiveVOS Tutorial

34

The ActiveVOS tutorial guides you through creating a Business Process Execution Language (BPEL) process,
testing the process in simulation mode, then deploying it to the server (and using remote debugging if you
deploy on-premises.

You will create a loan approval process definition. This definition describes the interactions among three
participants, as well as the control flow and decisions based on exchanged data. It is based on Web Services
Description Language (WSDL) documents that describe the messages and business operations used in the
process.

After you finish this tutorial, you will have worked with many of ActiveVOS capabilities.
The tutorial is divided into the following sections:

e Part 1: Starting a New Process
You will learn how to create the tutorial project, create and open a process document, and become
familiar with the ActiveVOS environment.

¢ Part 2: Planning and Designing a Process
You will learn how to use the Process Editor and its graphical toolkit to develop the sample loan approval
process BPEL definition.

o Part 3: Creating a Process Service Consumer Participant
You will learn to add a participant role for the process to provide the BPEL-required partner link.

¢ Part 4: Creating Partner Service Provider Activities
You will learn the powerful shortcuts in Process Developer for creating receiving, replying, and invoking
activities in a process by starting with a WSDL operation.

e Part 5: Adding Process Activities and Properties
You will learn how to:

- Complete a process definition by adding control flows.
- View your process in both a graphical and hierarchical view.
- Create namespaces, variables, and activities manually and define properties for them.

e Part 6: Adding Fault Handling
You will learn how to catch errors sent to the process.

e Part 7: Adding Compensation and Correlation
You will read a short discussion of these topics, which are not included in the sample process.

¢ Part 8: Simulating the Process
You will learn how to simulate process execution with sample data values.

¢ Part 9: Deploying the Process
You will learn how to create a process deployment descriptor file and package several files into a
business process archive for deployment to the Process Server.

e Part 10: Creating a Form to Run the Process



Part 1

You will learn how to deploy, run, manage, and test a process on the Process Server. You will create a
form to start the process from Process Central.

e Part 11: Debugging Your Process Remotely
You will learn how to set up remote process launch configurations to debug a process running on the
server.

e Part 12: Using the Web Services Explorer to Start a Process
You will learn how to start your process from an Process Server, such as JBoss or WebLogic by using the
Web Services Explorer.

. Starting a New Process

You can use Process Developer to design a process using top-down or bottom-up techniques. In the top-
down technique, you sketch out your process by dropping down activities within a bounding box that
automatically contains sequenced activities. You then add all the necessary information to bind the activities
to an implementation and add decision-making to make your sketch a working process. In the bottom-up
technique, you use the definitions of the implementation that are available when you begin process creation.
This tutorial covers both design techniques.

After completing Part 1 of the tutorial, you will be able to:

e Create a new orchestration project.

e Understand the nature of an orchestration project.

e Create a new process document in the Tutorial orchestration project.

e Familiarize yourself with the Process Developer tools that help you create a valid process.

When you are done, go to “Part 2: Planning and Designing a Process” on page 41 .

Tip: Set a Help Preference to display Help in an external browser. This lets you see this tutorial at all times,
especially when a modal dialog is open. To set a Help Preference, select Window > Preferences > Help. Next,
select In an external browser within the "Open help contents” picklist, as shown in the following illustration.
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Note: The illustrations of dialog boxes and wizards (for example, font and button color) that you will see in
this tutorial can look different from one version of Eclipse to another and your operating system may also
display them differently than are shown here.

Step 1: Create the Tutorial Orchestration Project

You will create an Orchestration Project in this tutorial. An "orchestration project” is an Eclipse project with a
special nature for including the resources required for composing BPEL processes. These resources include
WSDL, schema, deployment files, and other specialized resources like Service References. In addition to
folders, an Orchestration Project has builders, which ensure that all orchestration files are valid, helping you
to complete error-free orchestrations.

Like all Eclipse projects, an orchestration project is a container to store files, and it resides in your default
location, the Workspace folder selected when Process Developer was installed. Orchestration projects are
also created in the same Workspace location in the file system.

1. Select File > New > Orchestration Project.

2. Typein Tutorial for a project name, as shown.
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3. Click Next and select the Tutorial template.
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@
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4. Click Finish.

Your Project Explorer view should look like the following illustration. Notice that Process Developer created

folders to contain the resources needed for a BPEL-based orchestration. As you proceed through the tutorial,
you will be using each of these folders in the Tutorial project.
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Step 2: Create a New Process File in the Tutorial/bpel Folder

1. Select File > New > BPEL Process.
2. Select the bpel folder.

3. Inthe file name field, type in tutorial for your BPEL file. The .bpel extension is automatically added.
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Notice the Advanced button. Pressing this button displays settings that override defaults that you can
set in Preferences. It won't be used in this Tutorial, but you may want to press it to see what's there.

4. Click Finish.

Your new file opens as a blank document in the Process Editor, as shown in the following illustration.
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Notice the following user interface features:

Process file are listed in the Project Explorer view. Double-click on a Project Explorer file to open it.

A newly created process file is opened automatically in the Process Editor. The Process Editor canvas is blank to
begin with. When you open multiple files, they are displayed as different tabs. To switch between open files, click
on a tab.

To create a process, you will use the palette. Each palette group contains a set of icons, such as the Task group.
You can select a palette icon and drop it onto the canvas. The palette is closed by default. Rest your mouse on the
palette bar to auto-open it, or select the Show Palette arrow to open it.

The Properties view displays the attributes for the object in focus. In the illustration above, the tutorial.bpel
process is in focus in the Process Editor. If a file is selected in the Project Explorer, a different set of attributes is
displayed.

The tabs along the top of a view indicate that several views are stacked together. Select a tab to display a view.
Tip: You can close (hide), minimize, maximize, move, and rearrange views as desired.

If you select the Problems tab, you may see two error messages. One says, "No activity designated to create
instance" and "Container /process is missing a required activity." These messages are part of BPEL
validation. You can ignore them for now.

Note: The Tutorial orchestration project includes a Cheat Sheet. A default project does not. The Cheat Sheet
view is usually closed.
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Part 2: Planning and Designing a Process

“Part 1: Starting a New Process” on page 35 covered creating a new project and a new BPEL file.

After completing Part 2 of the tutorial, you will be able to:

e Understand the design of the loan approval process.

e Understand top-down vs. bottom-up design.

¢ Use layout features of the Process Editor to optimize process display.
e Review BPEL validation messages.

At the end of this tutorial part, you will understand the loan approval process we will build.

What is the Loan Approval Process?

The Loan Approval process starts by receiving a customer request for a loan amount. The risk assessment
Web service is invoked to assess the request. If the loan is small and the customer is low risk, the loan is
approved. If the customer is high risk, the loan is denied. If the customer needs further review or the loan
amount is for $10,000 or more, the request is sent to the approver Web service. The customer receives
feedback from the assessor or approver.

A top-down design would begin by adding activities to the Process Editor without adding any valid attributes
to them; for example:

RETWE Cuskomer Request for Loan Amaunt

q"f Inwvoke Risk,
" fssessor

what islisk lenvel
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large loan o review risk o rick high risk.
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'qu{, Invoke Loan
" Approval
l Approve Dery

Return Approval Response

This part of the tutorial familiarizes you with the Process Editor, demonstrating features you can use to
create a top-down design. You will not create a complete top-down design.

Part 2: Planning and Designing a Process 41



Step 1: Create a Receive activity
A BPEL process begins by receiving an input message. This means a top-down design would start with either
a Receive or a Pick activity, since they are structured to receive data from a business partner's Web service.

1. Ifthe tutorial.bpel file that you created in Part 1 is not open, open it in the Process Editor.
2. If Cheat Sheets view is open, close it to make more room.

3. Click the Show Palette arrow.

T | [8) Activevos |

4. From the Catch Event palette, drag a Message icon to the canvas.
The activity is labeled with Message.

5. Make sure that the message is selected. A selection box encloses it. When it is selected, the Properties
view displays Receive attributes.

6. To make the activity name more meaningful, do one of the following:
e Click on the activity label Message and type in Receive Customer Request for Loan Amount.

¢ In Properties view, type the following in the Activity Name field, Receive Customer Request for
Loan Amount.

Here's what your activity should look like.

reive Customer Request For Loan Amount
]

Step 2: Working with Layout Features in the Process Editor

You can use several features in the Process Editor to optimize the display of your process. You will now
complete a short exercise to demonstrate its layout features.

1. From the Task palette, drag an Abstract task to the canvas.
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2. Try the following features by selecting them from the toolbar:

Enn:lum Alilgn Auto Layout
|

2 ;1':":"’*’-:- o =

e Use Auto Layout to layout activities in a grid
e Select two or more activities and Align them
¢ Magnify the display area with Zoom

e Display the Thumbnail view to select one area of your design to view. By default the Thumbnail view
is closed. Open it from the Window > Show View command.

3. Delete the Abstract task.

Step 3: Save the File and Review BPEL Validation Messages

Take a moment to save your file. You will notice a change to your Receive activity icon as it now has a error
icon next to it. Also, this error is now within the the Problems view. These "errors" are added to the Problems
view by default when you save your file. They relate to the validation of BPEL code generated for your
process. You can see the BPEL XML code in the Source view of the Process Editor.

The errors listed in Problems view will automatically disappear as you complete this BPEL process in the
tutorial.

Continue to “Part 3: Creating a Process Service Consumer Participant” on page 43 .

Part 3: Creating a Process Service Consumer
Participant

If you have not already done so, complete or review “Part 1: Starting a New Process” on page 35 and “Part 2:
Planning and Designing a Process” on page 41 .

In Part 2 of the tutorial, you learned how to create a top-down design by arranging BPEL activities on the
Process Editor canvas. Now you will begin creating an executable process based on WSDL files.

In the Project Explorer view of Process Developer, you should have the following:

e Tutorial project

e tutorial.bpel that you created in Part 1

After completing Part 3 of the tutorial, you will be able to:

e Understand the imported WSDL and schema for the loan approval process and orchestrated services.

e Use the Participants View to create a Process Service Consumer.

e Create the receive and reply activities.
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Step 1: Viewing the WSDL and Schema

A Web Services Description Language (WSDL) file describes business operations that are invoked to carry
out the activities of a BPEL process. WSDL files, and the schema types and elements they import, are
required in order to create a valid executable BPEL file. A good practice is to include your business partners'
WSDL and schema files in your orchestration project so that you can easily move the files in the project to a
deployment package.

If you do not have access to WSDL files, you can create them in Process Developer.

Normally you would create an orchestration project folder and import (or create) WSDL files into it. To save
time, the WSDL files are already imported, as shown in the following illustration:

=z schema
|X] lnanRequest,xsd
[ test
== wadl
[#-|X] loandpproval wsdl
F- K] loanMessages.wsdl

=X 4R [0 anProc

[#- %] riskassessment,wsd|

The WSDL and schema file definitions are as follows:

loanRequest.xsd Schema that defines the data types used in messages. The schema is imported into
loanMessages.wsdl.

loanApproval.wsdl WSDL describing the approve operation for the loan approver partner service. The service is
invoked to approve or deny requests for large loans.

loanMessages.wsdl WSDL containing the message definitions for data exchanged among the service partners.
This WSDL is imported by the other WSDLs.

loanProcess.wsdl WSDL for the participation of the BPEL process itself, describing the request operation. The
BPEL process starts by receiving a loan applicant's request for a loan.

riskAssessment.wsdl | WSDL describing the check operation for the risk assessment partner service. The service is
invoked to check the risk level of an applicant applying for a small loan.

Step 2: Using the Participants View to Create a Process Service
Consumer

Participants are the Web services and clients using your process and the partner Web services your process
uses. A participant exposes an interface to exchange messages with other services.

The loan approval process has three participants: one participant is the process itself, playing the role of
receiving a customer request and replying to the customer. The other two participants are partner services
that are created later.

1. Right-mouse click on Process Service Consumers and select New Process Service Consumer.

Each process plays at least one participant role, that of being consumed by a Web Service to start the
process.
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2. Inthe Interface tree, expand Project and Project Reference Services to see three port types listed in the
Tutorial project. A port type is a required element of WSDL. It describes the operation to use for invoking
a Web service and the messages to be exchanged between Web services. These port types are defined
in the WSDLs that are provided with the Tutorial orchestration project. Select the LoanProcess port type.

3. The default Consumer Name is Process_Consumer. Rename this to loanProcessor to identify the
participant role that this process is playing.

@ Process Service Consumer @

Consurner Marne: | loanProcessar |

Interface

== Project and Project Reference Services
=2 Tukorial
= H Loanapproval
3B W | oarFrocess
- 12 Riskassessment
F-[= System Services
- [ Other Workspace Orchestration Project Services

Mamespace: htkp:ffdocs, active-endpoint., .55/ 200802 loanProcess, wsdl

Interface:  LoanProcess 5
[ izenerate Interface... ]
@j [ K, J [ Cancel ]

4. Click OK. The new participant is displayed, and you can expand it to show the interface details from

loanProcess.wsdl.

Step 3: Complete the Interface Details for the Receive Activity

The loanProcessor participant is consumed by the request operation to begin the process. Implement this by
filling in the details for the Receive activity.

1. Onthe Process Editor canvas, select the Receive activity.

2. Inthe Properties view, select the Receive tab on the left, and then select the drop-down arrow in the
Participant field, and select loanProcessor.

3. Inthe Operation field, select the request operation, as shown.
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4. Select the Data tab on the left.
From the Assignment Type picklist arrow, select Single Variable.

6. From the Variable picklist, select New Variable.

The New Variable dialog displays a suggested name and data type, based on the schema imported into
LoanMessages.wsdl.

7. Rename the variable to creditInformation, as shown.

@ Mew Variable E|
Yariable Marne: | creditInfarmation |
Scope: !_Fﬂzﬁs e |
Yariable Tvpe: |Element w |
@ | OF, | [ Cancel ]

Step 4: Create a Reply Activity

If you have not already done so, complete or review “Part 1: Starting a New Process” on page 35 and “Part 2:
Planning and Designing a Process” on page 41 .
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The request operation that the process starts with is a request-response operation. You now need to create
the mandatory reply. The reply tells the customer whether or not the loan amount is approved.

1. From the Throw Event palette, drag a Message to the canvas. Place it within the bounding box
surrounding the receive, as shown.

REEE"’-"E |:|_|r|' brnar Dom ek Fop | oo n I|:'||T||:|L"-|t

Message

Ackivity: [unnamed]
Tvpe: Sequence

In the Properties view, look at the Activity Name field, then name the Reply Return Approval Response.
In the Participant field, select loanProcessor.

In the Operation field, select request.

Select the Data tab.

From the Assignment Type, select Single Variable.

From the Variable picklist, select New Variable.

© N o o b~ 0N

Name the new variable approval.

After you save your file, you will notice that the errors that existed when you saved the file in Part 2 (see “Step
3: Save the File and Review BPEL Validation Messages” on page 43) no longer appear.

Part 4: Creating Partner Service Provider Activities

If you have not already done so, complete or review “Part 1: Starting a New Process” on page 35, “Part 2:
Planning and Designing a Process” on page 41, and “Part 3: Creating a Process Service Consumer
Participant” on page 43 .

In Part 3 of the tutorial, you created a participant for the process role and the associated receive and reply
activities. Now you will create the partner services that assess and approve or deny the loan request.

In the Project Explorer view of Process Developer, you should have the following:
e Tutorial project

e Tutorial/bpel/tutorial.bpel thatyou created in Part 1

After completing Part 4 of the tutorial, you will be able to:

e Create the risk assessment and loan approval partner service participants.

e Create the risk assessment activity.

Step 1: Create the Risk Assessment Service Provider
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Recall that the process receives a request for a loan approval and is evaluated by the risk assessment
service. This service checks the customer risk level and loan amount.

1. Ensure your file, tutorial.bpel, is open in the Process Editor.

2. Inthe Participants view, right-mouse click on Partner Service Providers and select New Partner Service
Provider.

3. Name the service provider RiskAssessment.

4. Notice that the Interfaces tree displays the LoanProcess port type already in use for the process. Expand
Project and Project Reference Services to display available port types, and select RiskAssessment, as
shown.

@ Partner Service Provider @

Provider Mame: | Provider |

Interface

£| kutorial - Imported Services |
[= Project and Project Reference Services
=2 Tukorial

w2 Loanapproval

[+ t: LoanProcess

-

essmenk

&
[= System Services v

&

Mamespace: httpiffdocs, ackive-endpoint. .. 2008/02/riskassessment  wsdl

Interface:  RiskAssessment EM

[ Import Service Reference, .. ] [ Generate Interface. .. ]

@j [ Ok ” Cancel ]

5. Click OK.
Step 2: Create the Invoke Risk Assessor Activity

The process requires invocation of the risk assessment service. Here's a shortcut:

1. In Participants view, expand RiskAssessment.

2. Select the check operation, as shown in the example.
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@F‘articipants s {X) Process Yariabl = O

=

=1 | Process Service Consumers

&1 loanProcessor

= B Partner Service Providers

| ® Riskassessment

Drag the check operation to the Process Editor, and place it between the receive and reply, as shown.

Receive Custamar Request for Loan Amounk

i} check.

]

Return Approval Response

A new invoke activity is automatically created, named check. In the Properties view, change the Activity
Name to Invoke Risk Assessor.

Notice that the participant and operation are automatically filled in.

From the Color property palette, select Blue. Color adds a visual difference between participants.

Select the Input tab.
In the Assignment Type field, select Single Variable.

From the Variable picklist, select creditinformation, as shown.
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8. Select the Output tab.
9. Inthe Assignment Type field, select Single Variable, if needed.
10. From the Variable picklist, select New Variable.

11. Inthe New Variable dialog, name the variable riskAssessment, as shown.

[l Properties 52 [21 Problems | o5 Tasks| 414 Servers | ] Error Log | =
CEERE

":L‘.t Service

Irwvake | Assignment Type: i%—i;l;;;.l'-;ame -
. Input | o :
Dutput e 5
R Documentation
al v

Tip: Receive and Reply activities can also be created automatically (like these invoke activities) by dragging a
process service consumer operation to the Process Editor.

Step 3: Create the Loan Approval Service Provider
Next, create a service for the process.

1. Inthe Participants view, right-mouse click on Partner Service Providers and select New Partner Service

Provider.
2. Name the service provider LoanApproval.
3. Expand Project and Project References Services to display available port types, and select LoanApproval.
4. Click OK.
5. Saveyour file.

The Participants view should look similar to this:
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You will create the invoke loan approval activity later.

Part 5: Adding Process Activities and Properties

You have now completed parts 1 through 4 of this tutorial.

In the Project Explorer view, you should have the following:

e Tutorial project

e tutorial.bpel that you created in Part 4

After completing Part 5 of the tutorial, you will be able to:

e Use the Outline tab to see your process in a hierarchical view.
e Rename a namespace prefix.

e Create an If activity.

e Create if conditions using the Expression Builder.

e Understand the Create Instance attribute for the Receive activity.
Step 1: Use the Outline Tab to Add and Select Building Blocks

The Outline tab (also called a "view"), shown displays all major components of a BPEL process. Here are two
Outline views. The one on the left is the default for a new process, containing only the parent nodes. Your
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outline should look like the one on the right. By starting your process using participants, you have
automatically added a namespace, participants, variables, and several activities.

oF outine 5% =l = Cutline 52 =)
= ﬂ MNewProcess = ﬁ

- ragy Extensions

[ ;IJ':;‘J Extensions -
o Imports

‘E‘ Irnports

23]

(f,:}' Mamespaces
I participant Partner Links *

4 lnanProcessar

[
=+

:___ }- fé,y MNamespaces

1
2]

g 1T

B Participant Partner Links

{x) variables
| *F RiskAssessment

= || Correlation Sets -
“ | * Loanapproval

| Process Activities o (%) variables *
A4 ) Fault Handlers ' {2¢) creditinformation
Event Handlers fx) approval

() riskissessment

= |} Correlation Sets

=} _|Pr0cess Activities *

[ Receive Customer Reguest For Loan

i

A Return Approval Response
& Q‘ Invoke Risk Assessor

[# - A ) Fault Handlers

1 Event Handlers

1. In Outline view, select Correlation Sets.

2. Click and hold the Correlation Sets node, drag it to the bottom of the outline, and move it slightly until
you see a black bar, indicating you can drop it. The loan approval process does not include correlation
sets, so you can move this node out of the way.

! Fault Handlers

49 Event Handlers

ar
L 1IFE
g e

Tip: You can move items up and down to reorganize them. You can right-mouse click on a node to add
new items of the same type.

Step 2: Rename a Namespace Prefix

Each WSDL and schema file declares one or more namespaces that provide a context for messages, port
types, and other definitions. The namespaces that are declared in the schema and WSDL files that your
process references must also be declared in the process itself.
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Because one namespace can have many WSDL files associated with it, Process Developer identifies the
WSDL file by using the Imports function. The import is automatically added when you create a participant,
and a default namespace prefix is also added, which you can rename to make more meaningful.

1. In Outline view, expand Imports to see the location of the WSDL.
0= outline 57 =
=l

e T+) Extensions

=] "p Imports
'ﬁ'} . JachemafloanRequest.xsd {htkp:/fschemas. ac
‘j:l' JwsdlfloanPraocess, wsdl {htkp: [ docs, active-er
ﬂ! . Jwsdlfriskfssessment, wsdl {htkp: [/ idocs, ackive
'f,.i-' o Jwsdlfloandpproval wsdl {hikp:fdocs, active-e

'rﬂ:r . Jwsd|floanMessages.wsdl {http:j/docs., active-

2. Expand Namespaces and notice the new namespaces. The loan prefix and the loanMessages prefix are
two of the namespaces added.
Process Developer creates namespace prefixes based on WSDL filenames and adds them to the
process. The loanProcess.wsdl generates the loan prefix the loanRequest.xsd file and 1oanMessages
for loanMessages.wsdl file.

3. Notice the prefixes for all imported WSDLs, which will appear in variable expression that you will create
in the process:

WSDL/XSD file from the Namespace URI Prefix
loanRequest.xsd loan
loanMessages.wsdl loanMessages
loanProcess.wsdl loanProcess
riskAssessment.wsdl riskAssessment
loanApproval.wsdl loanApproval

Tip: All new processes contain common namespaces. The xsd namespace defines the location of the XML
schema. The bpel namespace defines the location of the BPEL schema. Process Developer adds other
namespaces used internally by the process.

Step 3: Adding Programming Logic with an If Activity
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The risk assessment determines who is a high risk or low risk, or who needs more review. These conditions
will be represented using the If control flow activity.

1. From the Control Flow drawer of the palette, select a Conditional Pattern activity and drop it just below
the invoke activity as shown.

Receive Customer Request Far Loan Anmaount

'I*'g Irvoke Risk
Assessar

L-:unthlqrnal Fatterm
'
o
If Condition Else
_.. ‘_
|

Return Approval Response

Note that the activity is already structured with If and Else conditional paths. The else condition is
indicated with a slash at the beginning of its path.

2. We need to add an Else If condition. Select the starting diamond of the If, and right mouse-click to select
Add > Other > If Condition, as shown.
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Receive Customer Fequest far Loan amounk

Invoke Risk

fssessar ‘
¥ ondiognal Fatkerm
Fir
4 ale | I - S ™ - S - — .I
' e B v condton |
! Link... -
IF Condition -

F'i, Auko Layouk
|, Make Horizontal

|of Cut
1= Copy

Select the first If Condition label and rename it 1arge loan or review risk.
Tip: Click once to select the label and then click the text to edit it.

Select the next If Condition label and rename it 1ow risk.

Be sure to label the two if conditions in order, left to right. The left-most condition is evaluated first at
runtime, as you will see later.

Select the Else label and rename it high risk.

Select the Conditional Pattern label and change it to what is risk level.
Here is what your process should look like:
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Receive Customer I1equest for Loan Armounk

Invoke Risk,
Assessar

what islisk level

4,
Y

LV

large loan or resiew risk low Fisk: high risk

L 4
f

Return Approval Response

7. Save your file. More errors are reported, which will now be fixed.

Step 4: Create Conditional Expressions
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Begin by adding conditional processing for each if condition path.

1.

Double-click the 1ow risk If activity (not the label) to open the If Expression Builder, as shown.

4

Invoke Risk
AssES500

Cunditiinal Pattern

o risk,
L™

.__"-

@ If Expression Builder

Expression Language: | urn:oasis:names:koiwsbpel: 2. 0:sublang: xpath1.0

Variables Functions Ciperators

In the Builder dialog, expand the riskaAssessment variable and double-click the riskAssessment part to

€ approval A | E-EPEL A || - Arithmetic
: : — | - String [+~ Logical
&€ > creditInformr v | & Murnber [ Relational

add an expression to the If Expression box.

Complete the expression as follows: SriskAssessment/loan:riskAssessment = 'low' Thisis shown in
the following example.
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2 If Expression Builder |Y|

Expression Language: i urn:oasisinames;tciwsbpeli2,0:sublangixpathl.0 |
‘ariables Funictions Cperators
- < } approval [#- BPEL [#- Arithrmetic
! / : [+ Skring [+ Logical
[+ H
& £ ¥ creditinformation % Number = Relational
El() riskAssessment [+~ Boolean i = (equality’
- Y riskAssessment [riskAssessmentResponse] - Node Sets i ':::Teq”al_lli
: pew=(less k
LA ) riskAssessment® [RiskAssessment] . < (less thar
i w= (greate
i (greaker

[+ Location

£ | *
If Expression: [ b Insert
¥ frisklissessment/ loan:risklissessment = ' low’
@ [ (a4 ] [ Cancel

4. Forthe large loan or review risk condition, create an expression for two conditions:
a. Expandthe creditInformation message, and double-click the amountRequested part.

b. Complete the expression by adding the large loan amount and the risk assessment review condition,
as shown.

ScreditInformation/loan:amountRequested >= 10000 or
SriskAssessment/loan:riskAssessment = 'review'
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2 If Expression Builder @

Expression Language: iurn:oasis:names:tc:wsbpel:2.D:sublang:xpath1.D |
Variahles Functions COperators
&¥ responseEmail* [string] # || m-BPEL - Arithmetic A
d [#- Skring = Logical
£ FirstapprovalTaskRef [anyURI] - Fumber ‘.- and (boolean and)
=&Y riskissessment [#)- Boaolean -or {boolean or)
=€ ¥ riskissessmentt [riskissessmentResponse] B fode Sets || &= Relational L
i i | = (equality)
bt 2o 1= (ineguality)
& |3 i <= (less than or equal) ~

If Expression: I Insert

|$credit1nf0rmation,-’lDan:amount.Requested >= 10000 or
Srisklissesswent/loan:riskissessment = 'review!

2 | oK ] [ Cancel

Step 5: Create the Reply for the Low Risk Condition

If the customer requests less than $10,000 and is a low risk, the customer is approved for a loan. Here's how
to create a reply with this message.

1. From the Throw Event drawer of the palette, drag a Message to the blue bounding box of the low risk
condition as shown.

|
[ Fisk

"-H—i.:'
r Message .

Activity: [unnamed]
Tvpe: Sequence

2. Fill'in the reply properties in the Properties view as follows:
a. Activity Name: Approve
b. Participant: loanProcessor
c. Operation: request

3. Select the Data tab of the Properties view.
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4. Note that the Assignment Type is XPaths. XPath expressions allow you to select nodes from a variable

for assignment. You will now map a literal expression to the reply variable, as follows.
a. The table structure on this data tab allows for several XPath expressions. We need only one
expression. Select Add. (The button is to the right of the table.)
b. Inthe E/L column, select the f(x) (Expression) entry and change it to (k) Literal expression.
c. Click in the From column and select the Dialog (...) button to open the Literal Contents dialog.
d. Select Generate, and in the XML Data Wizard, notice that the matching data type,
loanApprovalResponse, is selected as the Root Element. The element-based approval message is a
single part element.
e. Select Finish. The Literal Contents looks like the following:
@ Literal Contents
Edit literal contents:
<lnan: lnanApprovalResponse
wrins:loan="http://schemas. active-endpoints. com/sample/LoanRequest /200802 loanF.equest, xsd" =
<lnan:responseToLoanFequest =approved </loan:responseToLoanf equesk =
<!--Optionali-- =
<lnan:responsebescription=string <floan: responselescripkion =
<!--Optionali-- =
<lnan:rejectionReason >
<!--Optional;-- =
<loan:reason=lowCredit<loan;reason =
<!--Optional:-- =
<loan:description =string <floan;description =
<floan;rejectionReasan =
<floan:loandpprovalfesponse =
-
@ [ cenerate. .. | [ K ] [ Cancel
f. Replace the loan:responseDescription string with the following: Your excellent credit has
earned you automatic approval for your loan.
g. Delete the entire <loan:rejectionReason> </loan:rejectionReason> element. The literal
expression will be:
<loan:loanApprovalResponse xmlns:loan=
"http://schemas.active-endpoints.com/sample/LoanRequest/
2008/02/1loanRequest.xsd">
<loan:responseToLoanRequest>approved
</loan:responseToLoanRequest>
<loan:responseDescription>Your excellent credit has earned you automatic
approval for your loan.
</loan:responseDescription>
</loan:loanApprovalResponse>
The Data tab should look like the following.
=) Message
Reply Assignment Type: EXPaths w
Data

all

Dacumentation EfL |From Ta Part To Path
= <loan:lbandpprovalkesponse xmins:loan="http: /1

schemas, active-endpoints, comy'sample/LoanRequ
r‘{,) estiZ008/02/loanReguest. xsd" =

<lnan:responseToloanR equest =approved < loan
rresponseToloanRequest=

Dacurment
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Step 6: Create the Reply for the High Risk Condition

The reply for the high risk customer is created with almost identical steps used for the low risk customer.
You can use a shortcut and make a copy of the approve reply to create the deny reply.

1.

Copy the Approve reply and paste it into a blank area of the canvas. The reply is pasted into the top-left
corner.

In the Properties view, rename the Activity Name to Deny. The Participant and Operation are already filled
in.
In the Data tab, select in the From cell to display a dialog (...) button, and then select it.

Select Generate, then Finish.

Edit the literal contents for the denied loan. The message should read as follows:

<loan:loanApprovalResponse xmlns:loan=
"http://schemas.active-endpoints.com/sample/LoanRequest/
2008/02/loanRequest.xsd">
<loan:responseToLoanRequest>
declined
</loan:responseToLoanRequest>
<loan:responseDescription>We are sorry, this application
falls outside of our credit risk guidelines.
</loan:responseDescription>
<loan:rejectionReason>
<loan:reason>lowCredit</loan:reason>
<loan:description>low credit score
</loan:description>
</loan:rejectionReason>
</loan:loanApprovalResponse>
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6. Drag the Deny reply to the bounding box in the high risk condition. Your process should now look like the

following.
| :I
Receive Custamer Fequest For Loan Amaunt
ﬁ:_, Invoke Risk.
Assessor
what islisk lesvel
My
g ‘
large loan or review risk o risk, hirh risk,
(=) (=)
P.pi:uru:u\-'e Dehy
Return Approval Response

Step 7: Create the Invoke Loan Approver Activity

You have one more path to complete for the If activity: the case where the loan request is large or the
customer's risk level could not be determined by the risk assessment service.

Recall that you have already created two partner services for the process and are already using the risk
assessment service via the risk assessment invoke activity. Now you will use the loan approval service.

1. Inthe Participants view expand Partner Service Providers to view the LoanApproval partner.
2. Expand LoanApproval to view the approve operation.

3. Drag the approve operation to the bounding box of the large loan or review risk condition. A new invoke
activity is created, as shown.
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4
5
6.
7
8
9

large loan or review risk
i

¥

i approve

In the Properties view, name the activity Invoke Loan Approval.
Select Green for the activity color.

On the Input tab, in Assignment Type, select Single Variable.

For the Variable, select creditInformation.

On the Output tab, in Assignment Type, select Single Variable.

For the Variable, select approval.

Step 8: Add the Loan Approval Reply

Select the Return Approval Response reply and drag it into the bounding box containing the new invoke
activity. Be sure to move the activity very close to the bottom of the invoke activity to place it in sequence
inside the bounding box.

Notice that the process now has three discrete end activities, clarifying the process flow.

Your completed process definition should look like the following.
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Recfive Cuskarmer Request Far Laan Amaunt

'qf‘-[ Irvoke Risk,

Assessor

whak islisk level

5
"-.

large loan of review risk o risk high risk.

¥
'q'.'é Invoke Loan

Approyal

l Approve Dery

Return Approval Response

Step 9: View the Create Instance property for the Receive activity

The Receive is the activity that kicks off the process, so you want to ensure that the Create Instance property
is enabled. Process Developer automatically adds the Create Instance property to the Receive (or other start)
activity that you add to the process.

1. Inthe Process Editor, select the Receive activity.

2. Inthe Properties view, notice that a checkmark was added to the Create Instance box.
Step 10: Save Your File and Validate Your Process

1. Save your file. When you save it, it is automatically validated for BPEL.

2. View Problems view, stacked next to Properties view. There should be no errors listed.
If any errors are listed, double-click the error to go to the source of the error.

Tip: You can compare your file to tutorialCompleted.bpel to discover any differences. To open a
completed version of the tutorial, select File > New > Orchestration Project, name the project, click Next, and
then select the Template Tutorial Completed.

Note that the tutorialCompleted.bpel file has one difference: The sequence surrounding the process was
removed by using the Ungroup right-mouse menu option.

You have completed the main process definition.

Part 6: Adding Fault Handling

To start at the beginning of the tutorial, see “Part 1: Starting a New Process” on page 35.
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Fault handling in a BPEL process is reverse work, undoing the partial and unsuccessful work of a scope in
which a fault has occurred. When a fault occurs, normal processing is terminated, and control is transferred
to the associated fault handler.

So far in the tutorial, you have completed a BPEL process definition that contains all the steps for normal
processing. Now you will add a fault handler to handle a service invocation fault.

If the loan process throws a fault, it terminates the process using a standard fault, and turns over control to
the fault handler activity.

In the loanprocess.wsdl file, there is a fault name and a fault message defined for the WSDL's operation,
namely the request operation. The loan process uses the fault name and message in defining fault handling
activities for the assessor and approver services.

In the Project Explorer view, you should have the following files:

e tutorial.bpel that you created in Part 2
e tutorialCompleted.bpel, which is a completed version of the file (optional)

After completing Part 6 of the tutorial, you will be able to:

e Add a Catch fault handler for the process.

e Add a fault variable.

e Add a fault handling activity to the Catch handler.
Step 1: Add a Catch Fault Handler and Fault Variable

When a fault handler receives an inbound fault message, it assigns the fault message to a variable before
proceeding to perform an activity enclosed by the catch.

1. Click on the Fault Handlers tab of the Process Editor.

2. From the Catch Event palette, drag an Error activity to the canvas.
3. Select the activity.
4

In the Properties view, select Fault Variable Definition, and click the dialog (...) button at the end of the
row.

5. Fill in the Fault Variable Definition dialog as follows and click OK:

a. Select the Element radio button.
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b. From the list of messages, select loan:errorMessage.

@ Fault Variable Definition =5

Variable Definition
@ Message Tyt§ () Element
Selected definition:

loanMessages:errorMessage

Select a message type:

(none)

loanMessages:approvalMessage
loanMessages:creditinformationMessage
loanMessages:errorMessage

loanMessages:riskAssessmentResponse

4 1

® ——

Cancel ]

6.
7.

In the Properties view, select Fault Name, and click the dialog (...) button at the end of the row.

In the Fault Name list, notice that the WSDL fault name associated with both the assessor and approver
services is the same, but each is in a different namespace. For convenience, the WSDL for each service
used the same fault name, but usually if you are orchestrating two different services the fault names
would be different. Select the 1oanApproval:loanProcessFault, as shown in the example.

@ Fault Mame E|

Fault Mame

(%) Scope Faults () Standard Faulks () Custom Fault

Current Faulk Mame:

Select a Faulk Mame:

loandpproval:loanProcessFault ]

riskAssessment: lnanProcessFault

] [ Zancel
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8. Inthe Fault Variable field, type errorApprove, which is the name we will associate with the fault variable
definition. The properties for the Catch activity should look like the following example:

El console | [21 Proble | B Propert 53 & Tasks | 4k servers| B PP ] Error L = [m]

BEE=

i

Error

e Catch All Faults; [7]
Documentation Eault Name:. | inanapprovaldoanProcessFaul 1]
All :

Fault Yariable Definition: [ £omant = loanserrarMessage B

Fault Yariable: | errorapprove

Notice that a new variable named errorApprove was to Process Variables view. This variable is exclusively
for fault handling, and this is shown using an icon that differs from normal process variables.

O Intetfaces | () Process variables 22 7 T O
(%) creditinformation

l['r.!i',.l' approval
(%) riskassessment

[ o} errorApprove

Step 2: Add a Fault Handling Activity

When a fault is caught, the fault handler must execute an activity. You will add a Reply activity to tell the
customer that the process was unable to handle the request.

1. From the Throw Event palette, drag a Message activity into the Catch handler and name the activity
ReplywithApprovalFault, as shown.

Errar

ReplawithapproyalFault

2. Fillin the properties for the reply activity to handle the fault, as shown in the example. You must select
them in the following order:

a. Participant (loanProcessor)

b. Operation (request)
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c. Fault Name (unableToHandleRequest)

= Properties 52 |:L F'ru:ul:ulemsE &3 Tasks.\; did ServersE & ] Error LDgE bl e

= Message

T " Implement as: | Reply v|

LS Activity Mame: | ReplywithApprovalFaulk |

Documentation

Al ] Participant: iln:nanF'rn:n:ess::nr v|
| Operation: Irequest v|

Faulk Mame: !unabIeTDHandIeRequest V|

Correlations: | (none) | E

3. On the Data tab, select the new variable (errorApprove).

= Properties £2  [21 Problems oz Tasksz o Servers | & Error Log =imy
]S ¥
= Message
Reply | Assignment Tvpe: | Single Yariable v|
Data

; Docurmentation
| all

4. Add a similar Fault handler for the risk assessment service by selecting the same fault variable definition
and the new fault name riskAssessment:loanProcessFault and naming the fault variable errorRisk.
Name the Reply ReplywithRiskFault.

Your Fault Handlers view should be similar to the following:

Chapter 3: ActiveVOS Tutorial



ReplywithApprovalF aulk ReplywithRiskFault

Process Activities |Fault Handlers | Event Handlers | Source

Part 7: Adding Compensation and Correlation

To start at the beginning of the tutorial, see Chapter 3, “ActiveVOS Tutorial” on page 34.

Compensation is the process of reversing or providing an alternative for a successfully completed activity,
especially when a fault occurs. Compensation restores data to what it was before the activity work was done.

Correlation is a construct for keeping track of a group of messages that belong together in one particular
business partner interaction. Correlation matches messages and interactions with the business process
instances they are intended for.

The loan approval tutorial does not require correlation or compensation.

For more information, see "Compensation and Correlation" elsewhere in this help.

Part 8: Simulating the Process

To start at the beginning of the tutorial, see Chapter 3, “ActiveVOS Tutorial” on page 34.

If you have followed all tutorial parts so far, you have completed a BPEL process definition that contains all
the steps for normal and fault processing.

Now you will turn from the design phase to the testing phase by simulating execution of your process.
In the Project Explorer view, you should have the following files:

e tutorial.bpel that you created in Part 2

e tutorialCompleted.bpel, a completed version of the file (optional)

After completing Part 8 of the tutorial, you will be able to:

e Complete the prerequisite checklist for simulation.

e Add sample data files for WSDL message parts.

¢ Display data values for process variables.

e Simulate execution of a BPEL process.

e Test all execution paths in a process by overriding default data values.

Step 1: Complete the Prerequisite Checklist for Simulation

Part 3: Creating a Process Service Consumer Participant 69



70

Process Developer validates your BPEL process before you execute it, adding validation tasks to the
Problems view for you to complete. The tasks are broken down into errors, warnings, and information. You
must ensure your process is executable, and you must complete all error tasks before running your process.

1. Open tutorial.bpel.
2. Ensure that the Abstract Process property is set as follows:
a. Select Properties view.
b. Click on an empty part of the Process Editor (or select tutorial from the Outline view).

c. Select the All tab in the Properties view and note that Abstract Process is set to No to indicate that
the process should be validated for execution.

T Properties £3 G Problems | gk Relationships | 47 Servers | €] Brror Log

|| Process Activities

Property
= EFEL 5i tion

Generake Prefixved Source
Aall rite Port Tune

Process

Abstract Process
Lok Il DuaFil

Process

Documentation

BPEL Mamespace http:/docs. oasis-open. orgfwshpel/2 . 0fprocess/execul
Camment

Create XPath es
Disable Selection Failure Wes
Dacurnentation

Exit On Standard Fault Mo

Expression Language

’ F ’ ilﬁuﬁiii&ttribulﬁ Eiﬁi:editStyle) P

3. Ensure that Process Developer is reporting BPEL validation tasks, as follows:

a. Select Window > Preferences > Process Developer > Tasks and Problems.
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b. All BPEL Validation settings should be selected, as shown.

E Preferences

| Evpe filker text | | Tasks and Problems
[+ General
[=)- Ackive0s Define task creation behavior,
i Cache and Timeouk
+ Colors and Fonkts [ |Enable user defined task tags
- Contribution
- Zuskom Functions Tag Priarity
i+ Identity Chooser iDtodo Marrnal
o — TODO High
- Remote Debug
- Simulation
® Tasks and Problems
- 'eb Page Editar
- Ant /'.'—_--‘"'\_
[+ Business Process
- Data Management BPEL Validation
[+ Help
- Install/Update Enable Error Problems
[ Jarva Enahle Warning Problems
Java EE
T Enable Info Problems
[+ Plug-in Developrment
[+ Report Design
[+ Run/Debug
+- Server

T

4. Validate your file by selecting the Validate Process toolbar button. This action ensures that all validation
tasks appear in the Problems view.

Wi R I ee- L x| Pl Bl XK )

5. Select Problems view.

6. If an error task exists, such as the one shown in the following example, correct the error, and save your
file.

[
¥

d Reply: AccepttdessageToCustomer

B Problems x
1 error, 0 warnings, 0 infos oo :

I Description Resource ] In Folder
@ Missing value for required field - variable.  tutorial.bpel ActiveBPEL_Tut

Step 2: Load Sample Data Files for the Messages
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To simulate process execution, you need to initialize process variables. Process Developer has a convenient
way to provide default data values and ways to override the defaults for different test scenarios.

When you create an orchestration project, you can add sample data files into the Process Variables view (or
into the Project Explorer). The sample data is registered and is available for all processes that use the
messages.

1. Expand the sample-data folder in the Tutorial project. Note that several files were created for you to test
with. You will load some of these files into variables for different test scenarios.

Select Process Variables view.
Open the creditInformation variable by double-clicking it. You can see the data type definition.
Right-mouse click creditInformation and select View Data.

Right-mouse click and select Load Data > From Project File.

o o h w DN

Select CredInfo_Jones5001.xml from the sample-data folder.
Your creditInformation variable should look similar to the following example.

' {x) creditInformation | Data X

. = (} creditInformation

= < ) loanProcessRequest

€2 loanType Auto

{ Y firstMame lames

£ % lastMame Jones

£ » davPhone 5&1

¢ » nightPhone 999

¢ ¥ socialSecurityMumber 05487 1564
£ % amountRequested 5001

£ ¥ lnanDescription

{  responseEmail

7. Load assessment low.xml sample data file for the riskAssessment variable.

Step 3: Generating a New Sample Data File for the errorRisk Variable

The errorRisk variable, as all the other variables, is defined with a schema complex type and requires
namespace-qualified sample data. This means the sample data file must contain references to the data type
definition. You will automatically generate a valid data file using the XML Data Wizard, as you can do with any
variable to create your own samples. This step is similar to generating literal contents for the Copy Operation,
as you did in Part 5 of the tutorial. This wizard uses the type definition located in loanmessages.xsd.

1. In Participants view, select the loanProcessor participant to view the request operation's messages.
2. Expand the Fault errorMessage.

3. Select the document part of the fault message, and from the right-mouse menu, select Generate Sample
as the illustration shows.
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{3_F‘articlp,an_ts 4 (x) Pracess Yariables i

Eﬂ Process Service Consumets
= loanProcessor

=) request
E} n Input; creditInformationMessage

\_‘1 Cukput: approvalMessage
- \_‘]_ Fault: unableToHandleRequest: errorMessage

L 3
- w Cpen

E*B Partner Service Providers +
: E;B RiskAssessment @ Add Sample
Eﬂ Generate Sample

E} : B Loanapproyal

F - o approve
Hurman Task Participants

The definition of the message points to a schema element, which was selected by the wizard as shown

4.
in the following example:
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Bl <ML Data Wizard

Preferences

Select a rook element and preferences for sample data generation.

Select ook Element

= Type (%) Element

-:nan ierrarMessage

Generate optional attributes and elements

Generate data for attributes and elements

Repeating Elements: | 1

Maximum Recursion Depth; 2__

Choices, Abstract Elements and Absktrack Tvpes

(¥} Generate first available only

() Generate first available with others commented out

5. Leave the remaining preferences as is, since they do not apply to the schema definition of this message,
and click Next.

6. Inthe Save Results wizard page, select the Tutorial\sample-data folder, and name the generated
sample data file errorSample.

7. Click Finish, and then expand the Document message part to see the errorSample.xml file.
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ag Participants ©7 . (%) Process Yariables v = O

—
[=} *"‘_J Process Service

= ‘3 LoanProcessar
= request
# \1 Input: creditInformationMessage
- \j Qukput; approvalMessage
B "], Fault: unableToHandleRequest: errorMessage

(=} ¥ Document

Consumers

L. ﬂ project: ftutarialfsample-dataerrorsample. xml

L_B' éF‘artner Service

Providers |

i @ Human Task Participants

If you wish to view the contents of the data file, right-mouse click it, and select Open. The XML file opens
in the editor. Close the file when you are done.

8. In Process Variables, notice that errorSample.xml was loaded into the errorrisk variable.

9. Your open process variables should look similar to the following:

(%) creditInfarmation | Daka
E € ¥ creditInformation
2 € ) loanProcessRequest
: () lmanType Auko
) FirstMamne Jamnes
D lastMame Jones
f.l') tiskAssessment | Data
é €Y riskAssessment
=4 2 riskhssessmentResponse
: € 2 riskAssessment I
(X) errorRisk | Data
B ) -rorrick '
= () errarMessage
: LY errorCode 1
S ( ) reasan skring

Notice the following visual information cues in the Process Variables view:

¢ In the Process Variables list, bold indicates an open variable.

e The errorRisk and errorApprove variables are two-toned, indicating they are available only as fault

variables.
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Step 4: Simulate Process Execution

If you have completed all previous steps in this part of the tutorial, you are ready to begin simulating

execution of your process.
1. Click on a blank part of the Process Editor canvas to activate the main toolbar.
2. Select the Start Simulation icon, as shown.

2 ActiveV0S Debug - tutorial/bpelftutorial. bpel - Active¥0S Designer,

File Edit Mavigate Search Project Run Process  Window Help
C-H@ i QF  B-0-Q- e EEF (28 Activev0s De... )
STE R SR : g |10 MEo- B 8
[Byprey 22 Buni | i || 2] butorial.bpel &5 |Skark Simulation of the Process] E
S-S alqf
#-1=2 Tutarial o
( |
Receive Customer Taquest for Loan Amount
Inwioke Risk
Assessor
what islisk lewvel
g
¢ e S = large | igw risk law risk high risk
() a2 ‘1:] Par | = l arge loan lor resiew ris ow ris ?
= %
/(%) creditinformation e | Pracess Activities | Faulk Handlers | Event Handlers | Source |
?japprwa g5 o5z ™ = 0| B Blr (BErr 2 1a|dibse| B1c| @l | = 8
(%) riskAssessment - s i : : : ; : —— |
= Extensions 28 | & |'§b| =Y
(} ErrorApprove e % = Sl =]
() errarmisk v g Imports | | Process Activities
| —1| &% Mamespares =
L cre.c!ltlnformatlon X | ™ Participant Partner Link, b Process Frpcess Riame: |—tutorial |
=
= € ¥ creditinformation [lo. “l == T ]
= (%) warisbles  Documentation | Target Mamespare: | kukarial |
5 < > loanType [<trir | ] | Process Activities Al
ol firsthame [stri || o »|
B2 | 2l || | >
i

3. Notice the changes to the Process Developer environment, as shown in the following example.
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@ Active¥0S Debug - tutorial/bpel/tutorial.bpel - Active¥OS Designer

File Edit Mavigate Search Proy 1§ Run  Process Window Help
i B $-0-Q- @R 24 52, actvenos ve.. | B
e B st : X | 25|10 ¥ o
[?j Proj 33 5; guni | — O ﬁ tutorial bpel 33 Y ]|
SR Al
122 Tutarial n n )
ORecewe Customer Request for Loan Amaount
L | | % Iwoke Risk |
- — 7
(x)pro 52 . ¥ par ] A |
| © = |
I ]
(x) creditInformation | €  w i | >
() approval | Pracess Activities Fault Handlers | Event Handlers | Source |
(2¢) riskassessment v [#5De 22 % |g=ou| = O [Blc 52 e | Br| @] s B1| 9| T O
ot “ """" = 6 = |tuborial (Process Id: 1)
| (%) aedtt | Data X e X % | Gk bE[EE 2 B-9-
i e ||[1] [2009-08-04 10:10:40.341] Process t
| F = [1] [2009-08-04 10:10:51.188] Process 2
9 ;:3 'ﬁi. Simulate Process .
= ﬂ tutorial [1] (Suspended) @
i = Receive Custamer REC]LE
Receive Customer
4 56 Active\OS Engine (84,02 10
b4 | || 85 I E:
kg
1 The perspective switches to a Debug perspective.
2 The beginning activity is highlighted
3 The current variable is highlighted
4 The sample data is cleared
5 The Debug view is opened to run and step through a process
6 The Process Console view is opened to report simulation events

4. Inthe Debug view, click the Step Into button to continue, as shown.
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%5 pebug 2 _@@ Breakpoints | 0= outling | ]

il e
= E‘:‘:h Simulate Process
= ﬂ kukorial [1] (Suspended)
= Receive Customer Request For Loan Amounk (Susm

Receive Customer Request for Loan Armounk

ﬁiﬁ ActiveMO3S Engine (37409 10:18 AM)

5. Step through your process, inspecting process variables as each activity is executed. The simulator
stepped through the low risk path because Jones is a low risk and the loan amount requested was less
than $10,000. The Process Editor canvas should look like the following example when you are done.

Peceive Customer Fequest Far Loan Armaunt

Irveoke Risk,
Assessar

large loan or review risk,

e
F A

Inwlrisk high risk,
Invoke Loan ¥
Approval
Approve Dy

Return Approval Response
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Step 5: Clear the Process Execution State

1.
2.

Click anywhere on a blank part of the Process Editor canvas.

On the main toolbar, click the Clear Process Execution State icon, which is next to the Start Simulation

icon.

Step 6: Override Default Values for Different Test Scenarios

The simulation path went through the risk assessor's service using the default sample data value of 5001. To
test the loan approval path, do the following.

1.

2
3.
4

Select the Receive activity.

In the Process Variables view, open the creditInformation variable.

Right-mouse-click and select Load Data > from Project File.

From the sample-data folder, load credInfo Jones15001.xml.

@ Select Sample Data

IUze this dialog to select sarmple data for the variable,

X]

== sample-data

(%]

¥

-
B

= [=l[=[=[==]=

B
L

approval_approved.xml
approval_declined. xml
assessment_high, xml

| assessment_low, xml
| assessment_review,xml

credInfo_Anyone20001 , x<ml
credInfo_spprovefaultS001, xml

| credinfo_AssessFaultS001.xml

credInfo_Jones15S001 . xml

| credinfo_Jonesso0l,xmi

credInfo_Smith 15001, xml

| error_amy . xml

CE

] [ Cancel

Save and rerun the process.

Notice that the simulation engine informs you that sample data is missing from the approval service, and
presents a list of valid data files that match the message. Select approval approved.xml.

Your simulation path should look like the following example:
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Receive Customer Request for Loan Armounk

& Invoke Risk
- Assessor

L

[
Lo B

|
large |'3'au'1'3"' FeENiEw risk
o risk, high risk.

i, Invoke Loan l

Approsal

Approve Dervy

Relm

[ =ulnlgs

8. Clear the process execution state.
9. Inspect the Process Console view to see all simulation events.
10. From the Debug view toolbar, select Remove All Terminated Launches.
Step 7: Simulate Fault Handling
In the loan approval process, a fault is thrown if the loan approval or risk assessment service cannot handle

the customer request. In “ Part 6: Adding Fault Handling” on page 64, you added two fault handlers to catch
this fault and send a reply containing an error code. You will simulate this.

1. Onthe Process Editor canvas, select the Invoke Loan Approval activity.

2. In Properties view, select the All tab, and under Simulation, do the following:
a. Set Result to Fault.
b. Set Fault Name to loanProcessFault.
Start simulation and step through the process.

4. The simulator executes the fault handler, as shown.
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— ReplywithApprovalFault _ﬁ?plywithRiskFault

5. Inthe Process Activities tab, the simulator shows the activity with a fault, as shown.

Receive Customer Reguest For Loan Amount;

1. Invoke Risk
Assessor
v \
# K
large loan or review risk
o risk, high risk,
[y 4k, Invoke Loan
© Approval
Approve Deny

Return Approval Response

6. Look at the Process Console view to see execution path events.
7. Clear the process execution state.

Tip: You can also simulate fault handling for the risk assessment service. The same fault message is defined
for both the loan approval and the risk assessment service.

To simulate fault handling for the risk assessment service, select the Invoke Risk Assessor activity and set
the Result property to Fault and set the Fault Name. Change the sample data file to use an amountRequested
to be less than 10000 and re-simulate.
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Part 9: Deploying the Process

If you have followed all tutorial parts so far, you have designed and debugged a BPEL process. You are now
ready to deploy your process. Deployment is the act of publishing your BPEL process to the Process Server
where it can run. In the deployment procedure, you use the WS-Addressing specification to define endpoint
references.

It is time to deploy the process to the ActiveVOS embedded server. Deployment is the act of publishing your
BPEL process to the ActiveVOS server where it can run. In the deployment procedure, you use the WS-
Addressing specification to define endpoint references.

In the Project Explorer view of Process Developer, you should have the following files:

e tutorial.bpel that you created in Part 2

e tutorialCompleted.bpel, a completed version of the file created in Part 2 (optional)
After completing Part 9 of the tutorial, you will be able to:

e Complete the prerequisite checklist for deployment.

e Create a process deployment descriptor file.

¢ Create a business process deployment archive.

e Deploy the business process archive to the server.

Step 1: Complete the Prerequisite Checklist for Deployment

A BPEL file is ready for deployment to the Process Server when there are no errors in the Problems view and
when a simulated execution of the process terminates normally.

1. Open tutorial.bpel.

2. Simulate the process, as described in “ Part 8: Simulating the Process” on page 69, and test all
execution paths.

Step 2: Create a Process Deployment Descriptor File

A Process Deployment Descriptor (.pdd) file describes the relationship between the participant partner links
defined in the BPEL file and the implementation required to interact with actual partner endpoints. You create
a .pdd file to add address information about your endpoint references. The .pdd file is an integral part of the
deployment package for the process.

Recall that the loan approval process has the following definitions for partner links:

e loanProcessor is the process service consumer. In BPEL terminology, the My Role partner.

e RiskAssessment and LoanApproval are partner service providers. In BPEL terminology, the Partner Role
partners.

You will assign an endpoint type for each partner role and will provide access protocol information for the
process role (My Role). An endpoint type is a binding property that indicates the actual service the process
interacts with. Different types give you control over specifying services you work with now and in the future.
In this tutorial, you will indicate a static reference to partner services.

1. Select File > New > Deployment Descriptor to open the New Deployment Descriptor dialog.
2. Select tutorial.bpel, and click Next.

3. Select the deploy folder to store your deployment descriptor, shown in the example below, and click
Finish to open the PDD Editor.
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@ Mew Deployment Descriptor,

Deployment Descriptor File
Specify a file for the deployment descriptar,

Enter or select the parent Folder:

|_ Tutorial{deploy

= =2 Tutarial
= bpel
= deploy
(== form
[+ Partner_Services
[~ sample-data
#-[= schema
o[ best
1= wsdl
2 =l

File name; | tukorial, pdd

Mext = Firish ] [ Cancel

Do not make any changes on the General tab.
On the Partner Links tab, select the LoanApproval partner link.

Select WSA Address from the Invoke Handlers list. This addressing technique provides flexibility in
deploying your processes into different server locations.

Select the dialog (...) button next to the Endpoint Reference text box. In the Endpoint Reference dialog,
notice that LoanApproval.wsdl is selected, and the matching service is selected as shown. Select OK.
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2 Endpoint Reference

Service | Policy Assertions |

Select service For Partner Link "loandpprovall T", Raole "approver”, implementing Port Type "ns13:LoanApproval®,

Mamespace: | htkp:f{docs, active-endpoints, com| samplefwsd|loanapproval f2008 /02 loanapprosal wsd|

Address: | urnix-vos:loancompany;LoanApproval3eryice |
Service: | LoanfApprovalService |
Pork: | LoanapprovalservicePark |
Sl |Iu:uan.0.|:uprm-'al.wsdl v|

Service - Pork

@ ,_ al's ][ Zancel J

WS-Addressing is automatically added based on the binding information in the WSDL file.

8. Onthe Partner Links tab, leave Static as is from the Endpoint Type list, as shown in the example.
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10.
11.
12.

Partner Links

Riskfssessment: Missing a partner role endpoint reference definition,

Mame Laocation Status

| LoanAppraval i

loanProcessor
@ Riskassessment Missing a partner role endpoint reference definition,

Partner Role My Role

Invoke Handler: '-.-'-.-"E-F'. Address

Endpaint tyvpe: skakic W | Service

Endpoint Reference:

<wsa:EndpointReference xminsiwsa="http: //schema
“wsa:dddress =urn;x-vos: loancompany: Loandppror
“wsa:serviceMame PortMame="LoanApprovalServic
< wsaEndpointReference =

Select RiskAssessment, select WSA Address as the Invoke Handler, accept the riskAssessment.wsdl and

service as the Endpoint Reference, and leave Static as the Endpoint Type.
Select 1loanProcessor, and in the My Role panel, select Document Literal for the Binding style.
In the Service field, type the name TutorialService.

Save and close tutorial.pdd.

Step 3: Starting the Process Server

You will now deploy tutorial.pdd and its resources to the server. The first step is to start the server.

Part 3: Creating a Process Service Consumer Participant

85



The Process Server consists of an engine running under Apache Tomcat. Tomcat is the servlet container that
is used in the official Reference Implementation for the Java Servlet and JavaServer Pages technologies.

1. Select the Servers view in the lower right of the workspace and then right-mouse click within it. Select
New > Server as shown in the illustration.

B Properties | [Z1 Problems [ %] Tasks [ 48 Servers &3 . @) Error Log | 5 3 O A= O

Server 4 State Status

2. Inthe Server type list, select Process Server, click Next, and select Finish.

3. Select the Start the Server button, as shown in the example.

' Properties | |51 Problems | <2 Tasks | 4L Servers &h Efl Errar Log |

ver at localhost [Stopped]
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4. As the server starts up, you see start up tasks scroll in the Process Console. Files are deployed to the
embedded server each time you start it. Many of these files are for BPEL for People activities that you

may want to create for your next project. After the server starts, you'll see the message at the bottom of
this figure.

El conscle £3 |_'f'_ Froblem | =] Properti | += Tasks | &7 Servers E TCR/IP EEI Errorla | — O
AckiverOS Server at localhost [Generic Server] O Act e r_: @Eg_] = .

e i S e S - i T e

>

Jul 29, 2009 Z2:36:10 PHM org.activebhpel.rt.bieException logWarning
WAPNING: WE-Security featurez will not be avalilakble. Error instar
Jul 29, 2009 2:36:25 PM org.activebhpel.rt.ieException logWarning

WARNING: Engine assigned as priwmary Schedule Manager.

Jul 29, 2009 2:36:26 PM com.sun.xmwl.ws.model.RBuntimelodeler getEx
INFO: Dynamically creating exception bean Class org.activebpel.rt
Jul 29, 2009 2:36:27 PM org.activehpel.rt.metro.servlet. belMetrokn
INFQ: #F#&Fx&%Eexs LetiveVol Enterprise Started

Step 4: Create a Business Process Deployment Contribution Archive

To deploy your process to the Process Server, you must add all relevant files to an archive file (.bpr file),
which is similar to a Web archive file.

1. Select File > Export > Orchestration > Contribution-Business Process Archive File and click Next.

2. Select the tutorial.pdd file to include in the archive, as shown in the following example.
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88

@ Export Business Process Archive

Contribution Specification
Select deployment descriptar files o be contributed, location of the
contribution {business process archive, BPR) and deployment method.

Select the deplovment descripkors o contribute:

= [#]E2 Tukorial
=[] (= deploy
8= bukorial pdd

Select the export destination:

BER. File: | [Tutorial/deploy/tutaorial bpr | [Ei[u:uwse... ]

Server Deployvment Opkion

Tvpe: |web Service v|

Deployment URL: | http:,l',l'lu:u:alhu:ust:BDEDTé_ctive-bpel,l'services,l'ActiveBpeIDepInyEﬂPR _i

Usernarne: [ [

Passwiord: [ [

Opkions

GEroup! | Tukarials

Descripkion: L.ﬁ._n:tive'-.-'OS T_L_l_t_u:urials |

Save the contribution specification as an Ant script in the workspace ( bprd)

BPRD File: : ,I'Tutu:urial,l'u:leplu:uw'tutEuFi_al.I:upru:l | [Brnﬂse... ]

@TJ < Back ]uext = | [ Einish ] [ Cancel

For the export destination BPR file, browse to the deploy folder and name the .bpr file
tutorial completed.bpr. Your path should be similar to the following:
Tutorial/deploy/tutorial completed.bpr

In the Type field, select Web Service. The engine's default address is automatically filled in for the
Deployment URL. If you changed your host and port information during installation, change the URL
here.)

Selecting this option automatically deploys your .bpr file to the Process Server upon completion of the
export.

Type in the Group name Tutorials and Description Process Developer Tutorials. These properties
help you identify groups of processes on the server as you develop many types of processes.

Select the check box next to Save the contribution specification..., and browse to the deploy folder.
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7. Name the BPRD file tutorial completed.bprd. This file is an Ant script which you can run to re-deploy
the bpr file whenever you modify a .bpel or .pdd file.

8. Select Finish. A deployment details dialog shows the results.

Your BPR file has been automatically deployed to the server, as indicated by the information dialog. You can
also see the results in the Process Console.

T = T, = : =
El consale 23 [Z0 Problem | £ Properti | o2 Tasks | 41 Servers| B Tcpiie | @) Error Lo |
ActivelD3 Server at localhost [Generic Server] Cilack O] i I;HE .IEIclgﬂ il =i .

Jul 29, 2009 2:36:10 PM org.activebpel.rt.bheException logWarning #
TWARBNING: W3-Security features will not be available. Error instar
Jul 29, 2009 2:36:25 PM org.activebpel.rt.bheException logWarning
WARNING: Engine assigned as primary Schedule Manager.

Jul 29, 2009 2:36:26 PM com.sun.xml.ws.model.RBuntimeModeler getEx
INFO: Dynawmically creating exception bean Class org.activebpel.rt

Jul 29, 2009 Z:36:27 PM org.activebpel.rt.metro.serviet, ieMetrokr
INFO: ¥ ActiveVO3 Enterprise Started
FO] [tutorial.bpr] Starting BPR archiwve deployment.

[tutorial.bpr] Finishing BPR archiwve deployment.

Part 10: Creating a Form to Run the Process

To start at the beginning of the tutorial, see Chapter 3, “ActiveVOS Tutorial” on page 34 .

If you have followed all tutorial parts so far, you have deployed a BPEL process to Process Server.

After deploying the process to the Process Server, you must deploy the partner services, and then you can run
the process by sending in a credit information request and getting back a response from the risk assessment
or loan approval service.

After completing Part 10 of the tutorial, you will be able to:

e View the Process Console in a workspace browser.

¢ Deploy the Risk Assessment and Loan Approval services.

e Create and deploy a process request form and Central Configuration file for Process Central.
e Signin to Process Central and send a request to the process and receive a reply.

Step 1: Open a Browser to View the Process Console

You can view deployment details for your processes in the Process Console.

1. Onthe Process Developer menu bar, select the Process Console icon.

2. The Process Console opens, using a URL of http://localhost:8080/activevos.
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Site:EN-DT | Deploy | Help

Dashboard

Access activity monitors

Active Processes

Server Status

Monitoring
iew process, task and server monitoring infarmation

Reporting

Yiew available reports

Catalog
Yiew the content of the server catalog

Administration
iew and configure the server and services and perform maintenance
tasks

On the menu, select Admin.

4. Select URN Mappings. Notice that a URN to URL mapping is defined. This mapping is for the address of
the Loan Approval and Risk Assessment services. (This URN mapping exists only in the embedded
server in Process Developer. If you are deploying to a different server, such as JBoss, you will not see
any pre-existing URN mappings. You must add them.)

URN Mappings

Delete URN URL

] urnx-vos:loancompany hitp:fMocalhost3080/active-hpeliservices/E{urn. 4}

| Delete Selected |

Add new URN Mapping

URN | |

URL | |

[ Add/Update Mapping ]

Normally you will add your own URN mappings. However, for the convenience of the tutorial, the partner role
URNs were mapped to a URL for you.
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Note: Be sure that the host port 8080 in the URL is correct. If you selected a different port during installation
of Process Developer, select the URN to open the URL for editing. Update the URL so that the host port
matches your server host port.

Step 2: Deploy the Risk Assessment and Loan Approval Services

The Loan Approval and Risk Assessment services have been created as BPEL processes for the convenience
of this tutorial, and they have already been packaged in a BPR file. You must deploy these services. Then,
when you execute the tutorial process, one or both of these services will also execute. They will be invoked at

the URL defined in the URN mapping.
Site: EN-DT Help

1. Inthe Process Console, select Deploy as shown.

4 HOME | MONMOR | REPORT | CATALOG | ADMiN  Search: | Enter FID or Resource ;
~ s Welcome to the ActiveVOS Console
Dashboard
Active Processes * Dashboard
Access activity monitors

Server Status

Monitoring
View process, task and server monitoring infarmation

e
E Reporting
View available reports
—

Catalog

View the content of the server catalog

Administration
iew and configure the server and services and perform maintenance
tasks

2. Inthe Deploy dialog, browse to the following location:

[Process Developer installation folder]\
Process Developer\workspace\Tutorial\
Partner Services\riskAssessment.bpr

3. Deploy this BPR, and select Deploy another resource and select the loanApproval .bpr.

You can view the deployed processes. Do this in the Process Console by selecting Catalog, and then Process
Definitions. You will see the listing for the tutorial, risk assessment, and loan approval processes.

Step 3: Create a Process Request Form

You will now use Process Central to send a request to the process to start it. Process Central is a client
application that contains forms, as well as other work items, such as tasks and reports.

1. Select File > New > Process Request Form.

2. Inthe wizard, select the request operation, which is the operation for the starting receive activity.
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@ ActiveY¥0S Central Process Request Form

Select Port Type And Operation

Select the port kype and operation ko creake a form,

Interface

|type filker bext

= Project and Project Reference Services
4 (= Other Workspace Orchestration Project Services
4 2 Tutorial
¢ E LoanApproval
I LoanProcess
I RiskAssessment

3. Select Next and name the file tutorialRequest.html. Notice that the file will be added to a new folder
called request. (This name is not related to the request operation. It is a generic name for all process
requests that you may create for a project.)

4. Select Finish. Your process request form opens in the Web Page Editor, as shown.
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~|
25 214

equest Process Request )

Loan Process Request

Loan Type: J *
First Mame: J u [
i A il |
<?xml version="1.0" encoding="iso-8855-1"7> |
<!DOCTYPE html PUBLIC "-//W3C//DTD EHTML 1.0 Transitional//EN"™ "http://www—
<html xmlns="kttp: ‘www.wi.org 1299 xhiml "=
<head:>
<meta http-squiv="Content-Tvpe" content="text / himl s charset=IZ0-855%
<titlerActiveVW03 Process Regquest Form</titles
</ head>
<k o
2 »
_Design | Preview )

5. Select the first occurrence of Request from the form title, Request Process Request and change it to
Tutorial so that the title is Tutorial Process Request.

6. Notice that the input message is in a table, and the title of the table is Loan Process Request. This title is

based on the schema element of the message. We will change it to provide instructions for testing
different paths in the process.

7. Openthe HTML Palette, and drop a table beside the input message header, as shown:

Tutorial Process Request

Loan Process Requeaﬂ
: |F'Ian:e after span, inside u:Iiv|

8. In code view, add the following HTML code between the <table></table> tags:

<tr><td>5000 &lt;loan amount &lt;=20000</td>
<td>Jones is declined</td></tr>
<tr><td>20000 &lt;loan amount &1t;=50000</td>
<td>Only Smith is approved</td></tr>
<tr><td>loan amount &gt; 50000</td>
<td>Everyone is declined</td></tr>
<tr><td>Last Name: Approvefault</td>
<td>Loan approval faults</td></tr>
<tr><td>Last Name: Assessfault</td>
<td>Risk Assessment faults</td></tr>

9. In code view, your HTML code should be:
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<dive-
<Span class="&vq_heading“>LDan Process Request</span>
<tablex

<Erx<td>5000 &£lt;loan amount &1t;=20000</tds<td>Jones iz deelined</td></tr>
<tr><td>20000 &lt;loan amount £1t;=50000</td><td>Only Smith is approved</td=</tr>
<tr><tds>loan smount &gt; 50000</tds><tdrEveryone is declined</tdsr</trs>
<trr<tdrLast Nawe: Approvefault</tdr<tdzLoan approval faults</cds</trz
<trr<tdxLast Name: Assessfault</tdr<cd>Risk Assessment faults</tds</tr>
k/raniss
</fdive

10. Your form should look like the following example:

L oan Process Request

15000 <loan amount <=20000 - Jones is declined

20000 <loan amount <=50000

Onily Smith is approved

loan amount = 50000 Everyone is declined

Last Marne: Approvefault Loan approval faults

Last Marme: Assessfault Rigk Azsessment faults

Loan Process Request

Loan Type * |

First Mame

*

Last Wame * |

Day Phone + I

Night Phone

*

Social Security Number + |

Amount Requested * I

Loan Description #+ |

Other Info |

Response Email + |

First Approval Task Ref

Send Reguest

11. Save and close your form.

Step 4: Create a Central Configuration File
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To deploy your form to Process Central, you must create a configuration file that contains deployment
information about the form. The purpose of the configuration file is similar to that of a Process Deployment

Descriptor.
1. Select File > New > Central Configuration.
2. Select the deploy folder for the location.
3.  Name the file tutorialRequest. The avcconfig extension is automatically added.
4. Select Finish, and the file opens in an XML Editor.
5. Select the Source tab to view the file.
6. Scroll down to the Requests section as shown.
<!-- EReguestz - example note that the walues should bhe replaced with those from your
<tns:requestCategorybefss>
<tng:requestCategorylbef id="FILL IN CATEGORY ID" nsame="FILL IMN CATEGORY MNAME":
<avecom:requestDef id="FILL IN REQUEST ID" name="FILL IN REQUEST NAME">
<gawvocom:allowedRoles>
saveoom:rolexFILL IN ROLE 1g/awvecom:roles
sgvecomirolerFILL IN ROLE 23/aver
< favocom:allowedRoless
sgvepomideseription>PROVIDE A REQUEST DESCRIPTION HERE.:f/aveeom:ideseriptions
<avcc0m:formLocation>project:KPATHITOHREQUEST_FORH.HTML<favccom:formLocation>
<favocom: requestDefs
</ftnsrequestCategoryDet>
<ftns:iregquestCategorybefas
——=
7. You need to uncomment the XML in this section. Add an HTML end comment tag (-->) at the end of the
Requests line, the top line shown in the illustration above.
8. Remove the end comment tag at the end of the Requests section.
9. Remove the <avccom:allowedRoles> section. There are four lines of code to remove.
If you make a mistake, close the form, delete it from the deploy folder, and create a new form.
10. Fill in the placeholder values exactly as shown. Note that the values are case-sensitive:
<tns:requestCategoryDefs>
<tns:requestCategoryDef id="education category"
name="Tutorial and Samples">
<avccom:requestDef id="tutorial request"
name="Tutorial Request Form">
<avccom:description>
Submit loan approval request (basic tutorial).
</avccom:description>
<avccom: formLocation>
project:/Tutorial/form/request/tutorialRequest.html
</avccom: formLocation>
</avccom:requestDef>
</tns:requestCategoryDef>
</tns:requestCategoryDefs>
11. Save the file. Your completed file should look like this:

&1 <'-— Recuests -—-»

S5Z  <tns:requestCategoryDefs>

53 <tns:reguestCategoryDef id=”education_cﬁtegory" name="Tutorial and Samples":>

54 <gwvocom:requesthet 1d="tutorial_request" name="Tutorizl Reguest Form">

5.5, <avocom:description>Submit loan approval reguest (bagic tutorial) .</awecom:descriptions

=11 <avc:c:0m:farmLDcat10n>project.:/Tut.or1alff0rm/requestftutor1alRequest,.Q;ml<favccom:formLDcat10n>
57 </favooomirequestDefs

58 </tna:requestCategorybet>

59 </tns:requestCategoryDefs>

Step 5: Re-deploy Your BPR Contribution
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Now that we have a request form and a configuration file describing how to display it in Process Central, you
can deploy the BPR contribution, because the Tutorial project was updated with new files. Each time you
update your project, redeploy the entire project to keep your files together as a contribution unit.

1. Inthe Project Explorer, select File > Export > Contribution-Business Process Archive.
2. Do not change any values on the first page of the wizard.

3. Select Next. Notice that two new resources were added to the contribution:

@ Export Business Process Archive

Catalog Resources

This page displays all resources, both process dependencies and addikional
resource, which will be deploved ko the server catalog,

Current Projeck Resource Dependencies Included in Archive

| Resource Type Process. .. A
loandpproval wsdl httpsffschemas. xmlsoap.. .. '
lnanMessages,wsd| htkp:/fschemas. xmlsoap.. ..
loanProcess. wsdl htkp:/fschemas. xmlsoap.. .. [
riskAssessment, wadl httpiffschemas, xmlsoap.. .. bl
L4 | >

Project Reference Resource Dependencies Excluded from Archive

Resource Twpe Process Group B

Additional Resaurces ko Include in Archive

Resource Type Process Group Dre|

tutorialR.equest, avoconfig htkpsffechemas., ..
tutorialRequest. html res; ftext himl
£ >
"
':?_,J Einish ] [ Cancel

4. Select Finish to deploy tutorial.bpr. On the server, you now have two contributions. The older one
(version 1) is offline and the new one (version 2) is online.

Step 6: Open Process Central and Submit a Request
Process Central is a great place to test the different paths of your process.

1. Ensure that the server is running and that you have deployed your BPR for your project.
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2. You can open Process Central from the Process Developer toolbar to view an embedded browser. To
open a larger, stand-alone window, select the Open Web Browser button from the toolbar.

3. Inthe Address bar, type in the following URL:
http://localhost:8080/activevos-central

4. In the Sign On screen, sign on with the following user name and password:
Username: manager

Password: manager
5. Inthe navigation area underneath Home select Forms.

6. Select the Tutorial and Samples folder. This is the folder you created in the

tutorialRequest.avcconfig file.

7. Click on the Tutorial Request Form in the work area. You will see the Tutorial Process Request form you
created.

8. Submit a request as follows:
e Inthe Last Name field, type in Jones (case-sensitive)
¢ Inthe Amount Requested field, type in an amount between 5000 and 20000
e Fill in the other fields as desired

9. Your form should look like the following:

Loan Process Request
5000 <loan amount <=20000 Jones is declined
20000 <loan amount <=50000 COnly Smith is approved

loan amount = 50000 Everyone is declined
Last Mame: Approvefault Loan approval faults
Last Mame: Assessfault Risk Assessment faults

Loan Type: !autn

First Mame: |ﬁxnn

Day Phone: |555-555-5555

|
|
Last Name:|Jnnes !*
|
|

Might Phone: |555-555-5555

*

Social Security Mumber: |555-55-5555

E

Amount Requested: |5I:ICIl

Loan Description: |a description

Other Info:

|
Response Email: !nnbndy@reply |*
|

First Approval Task Ref:

Send Request ]

10. Scroll to the bottom of the form, and select Send Request.
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11. The response from the loan approval process is displayed:

» Tutorial Process Request

= Process Qutput

Loan Approval Response
Response To Loan Request: declined
Response Description: We are sorry, this application falls outside of our credit risk guidelines.
Rejection Reason
Reason Description

lowCredit low credit score

Step 7: View a Completed Process

1. Inthe Process Console, go back to the Service Definition page, and select Home from the menu, and
then select Active Processes. Notice that two processes completed.

2. Onthe Active Processes page, select the tutorial process. You can see the actual results returned from
the risk assessment service. Because Jones is a credit risk, the loan was denied.

w
l_ .I
Receive Custamer Request for Loan Amaunk
o
Imvoke Risk,
Assessar
o
¥
‘ s
LY g
large loan or review risk @ v ‘
lows risk high risk
@ @ l v jv
'lh Invoke Loan
Approval
Approve Deny
&
Return Approval Response
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For more details about the two services, and to debug your running or completed process from within
Process Developer, go to “ Part 11: Debugging Your Process Remotely” on page 99 .

Part 11: Debugging Your Process Remotely

To start at the beginning of the tutorial, see Chapter 3, “ActiveVOS Tutorial” on page 34 .

If you have followed all tutorial parts so far, you have deployed and run a BPEL process on the Process
Server.

Before starting this part of the tutorial, we recommend that you complete “ Part 10: Creating a Form to Run
the Process” on page 89 .

In the Project Explorer view of Process Developer, you should have the following files:

e tutorial.bpel that you created in Part 4
e tutorial.bpr thatyou created in Part9

After completing Part 11 of the tutorial, you will be able to:

e Add a breakpoint to tutorial.bpel.

e Create a configuration file for launching a remote debugging session.
e Start a remote debugging session.

e Step through your process and inspect variables.

Step 1: Add a Breakpoint to tutorial.bpel

You can connect to a running or completed process from within Process Developer for remote debugging.
There are several options for remote debugging, and we will set a breakpoint in the process and then attach
to the running process when the breakpoint is hit.

1. Open tutorial.bpel in the Process Editor.

2. Right-mouse click on the Receive activity and select Add Breakpoint. The Receive activity should look
like the following example.

.i. |

Receive Customer Request For Loan Amount

Step 2: Start the server

The server must be running in order to start remote debugging, so start the server now (if it is not already
running) before setting up a debug configuration.

1. If the server is already running, as described in Part 10 of the tutorial, you can skip to Step 3.

2. Select the Servers view in the lower right of the workspace, and select Start the Server.

Step 3: Create a Configuration for Launching a Remote Debug Session

A remote debug configuration indicates where processes are running and how you want to attach to them.

1. From the Run menu, select Debug Configurations.

2. Inthe Debug dialog, select Remote Process and then select the New Launch Configuration icon in the
toolbar.

3. Inthe Name field, type tutorial run to breakpoint.

4. Inthe Main tab, note that the default Server URL is displayed for deployed server processes.
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5. Inthe Process Selection panel, select Manual process selection or breakpoints. This selection indicates
that you do not want to immediately debug a process, but rather will select a process manually.

6. Enable the option Attach to any process on breakpoint to indicate that a process containing a breakpoint

will be attached to, if not already attached, when a breakpoint is hit.
Your Debug Create, manage, and run configurations dialog should look like the following example.

E Debug

Create, manage, and run configurations

MlEER -
S 8 = Name: |tut0ria|_run_to_breakp0int |

type fitter text -
m% Authentication| #% Options| = Common

= |48 Remote Process
12§ New_configu

Server URL: | hittp://localhost: 8080 /active-bpel/services/ActiveBpeladmin |

Process Selection

(8 Manual process selection or breakpoints
() Prompt for process selection from list
O Stop on next process instance creation

Process location: | lﬂrowse...]

Attach to any process on breakpoint

Apply ] [ Revert ]

7 [ Debug l ’ Close ]

7. Select Debug to begin remote debugging for the current configuration.

Your Debug view should look like the following example.

FEpebug 57 % Breakpoints | o Qutline et Al

LTS[:‘G"

= B iackivedoS [Generic Server]
; gl CAckivevos|\Designeridesignertiretbinjavaw, exe
= ﬂE kukorial_run_to_breakpoint [Remoke Process]

[% Ackived0s Enterprise Server (http:fflocalhost 8030/ active-bpelfser:

Step 4: Instantiate the Process
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You can create an instance of the process by using the Process Central request form, as you did in Part 10 of

the tutorial.

1. In Process Central, fill in the form with Last Name of Jones and amount-Requested value of 10000.

2. Select Send Request.

Step 5: Begin Remote Debugging

1. In Process Developer, open all variables in the Process Variables view and position the view next to the
Process Editor canvas. Your Process Editor should look like the following example.

@ !

—_—

Receive Cukkamer Request Far Loan Amaount

large loan or revieva risk.

L3, Invoke Loan
© Approval

—

(=

M

i

Return Approval Response

¢ Invoke Risk
Assessor
Y
W
lova risk. higﬁ rish:
¥ e =, f"‘“\
(=) (=)
Approve Deny

Notice that the running process is stopped on the Receive activity with the breakpoint, as we configured.

In Debug view, click the Step Into icon on the toolbar. The debug highlighter moves to the Invoke Risk

Assessor activity. The creditInformation variable displays the data submitted by the Process Central

request.

as shown.

Click Step Into twice to terminate and disconnect the process automatically.

Inspect the approval variable. Notice that Jones is not going to get a loan. The reply indicates a decline,
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(x) approval
= L2 approval

#- 4 > rejectionfeason

=% 2 lnandpprovalResponse
4 > responseToloanl.. declined
& > responseDescripl.. We regret that, after careful review,

6. Repeat the above steps by adding different Last Name and amountRequested values.

The LoanApproval and RiskAssessment services are built on the following logic:

5000 <loan amount <=20000

Jones is declined, all others approved

20000<loan amount<=50000

Only Smith is approved, all others declined

loan amount>50000

Everyone is declined

Last name: Approvefault

Loan approver faults

Last name: Assessfault

Loan assessor faults

Next Steps

Create a new orchestration project for Human Approval Completed. This process replaces the Invoke Loan
Approval activity with a People activity, as shown in the illustration. The documentation that accompanies the
Human Task (BPEL for People) sample describes how to deploy and run the sample. You can also review the
Human Tasks help for details on building a People activity to add human workflow to your BPEL process.

v i':b’ Assess Risk
J————

Receive Loan Application

? risk

IZB Reviewloan
|
»

Unaér Review

I

- law risk. _O

Approve

high risk,

Deny

Part 12: Using the Web Services Explorer to Start a Process

If you deployed your tutorial to Process Server and do not yet have an Identity Service enabled, you will not be
able to sign into Process Central. Process Central requires that authenticated users sign in, enabled through
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the Identity Service in Process Server. The Process Central embedded in Process Developer is already
enabled.

To start your process from an Process Server, such as JBoss or WebLogic, use the following instructions to
use the Web Services Explorer.

Step 1: Launch the Web Services Explorer

You need to copy the TutorialService URL into the Web Services explorer in order to send a request to the
process.

1.

o o~ WD

From the Process Developer Run menu, select Launch the Web Services Explorer.
Select the icon (upper right pane) for WSDL Page.

Select WSDL Main.

Return to the browser, and in the Process Console, select Service Definitions.

On the Service Definitions page, select TutorialService.

From the address bar, copy the TutorialService URL:
http://localhost:8080/active-bpel/services/TutorialService?wsdl
Paste this URL into the Web Services Explorer WSDL URL field as shown:

Web Services Explorer

S5 Mavigator [# actions

=R/SDL Main

T
2 Open WSDL

Enter the URL of a waDlL document and click Go to explare.

‘W3DL URL Browse...

http:/flocalhost: G080 ackive-bpeliservices, TukorialService wsd|

Reset

Step 2: Send a Request to the Process

You can create an instance of the process by using the Web Services Explorer to initiate the Receive activity
in tutorial.bpel.

1.

2
3.
4

In the Web Services Explorer, select Go under the WSDL URL field.
In the Bindings table, select the link for the supported SOAP binding (SOAP 1.1).
In the Operations table, select the request link.

Fill in the message parts. The required parts are Last Name and amountRequested. Fill in smith for Last
name and a high amount, such as 15000, as shown:
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‘Web Services Explorer

5. Mavigator e [#] Actions &
5, WSDL Main A,
[ = loanProcessRequest =

B2 http:/flocalhost:B080 factive
%3 TutorialService loanType string
[=-[48¥ TutorialServiceBindin

=

firsthame string

lastMame skring

smith

dayPhone string

nightPhone string

socialSecurityMurmber string

amountRequested ink
15000

lpanDescription string

5. Select Go, which is located at the bottom of the message.

6. Click the Source link, and then double-click the Status box to see the SOAP request and response sent
and received.
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i status

wimlns: wsi="http:/ fwww.w3.0rg /2001 /XMLSchema-instance">
- <soapeny: Body>
- «g:loanProcessRequests>
zgDiloanType />
=g0: firsthame /=
zg0:lastMamezsmith</q0: lastNamez>
zg0:dayPhone /=
zg0:nightPhone /=
<g0:socialSecurityMumber /=
zg0:amountRequested:>15000</q0: amountRequested:
«g0:loanDescription />
<g0:responseEmail />
</qQ0:loanProcessRequest
</s0apenv:Body>

- S0AP Response Envelope:

wimlns: approvews="http:/ /docs.active-
endpoints.com/sample/wsdl/loanApproval/2008/02/loanApproval.wsdl"
xmins: bpel="http:f fdocs.oasis-open.org/wsbpel/2.0/process/executable”
smilns: loan="http:/ fschemas.active-
endpoints.com/sample/LoanRequest/2008/02/loanRequest.xsd"
wmins: loanmsg="http:/ /docs.active-
endpoints.com/sample/wsdl/loanMessages/2008/02/loanMessages.wsdl"
wmins: partner="http:/ /docs.active-
endpoints.com/sample/wsdl/loanApproval /2008/08/loanApprovalPLT.wsdl">
<loan:responseToLoanRequest=approved</loan: responseToLoanRequest>
<loan:responsebescription /=
<floanapprovalkesponses
</soapeny:Body>
</soapenv:Envelopex=

7. Inthe Process Console, go back to the Service Definition page, and select Home from the menu, and
then select Active Processes. Notice that two processes completed.
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On the Active Processes page, select the tutorial process. You can see the actual results returned from
the loan approval service. The high amount loan request was sent to the approver. The approver
approved the loan.

Receive Customer Request for Loan Amount

ih Invoke Risk

Assessor
o
P
‘ NE
' large loan or review risk @ @
lowy risk hiqh risk
@ —————— @ @
% Invoke Loan l Y
[ ) Approve Deny

L 4

Return Approval Response

For more details about the two services, and to debug your running or completed process from within
Process Developer, go to " Part 11: Debugging Your Process Remotely” on page 99 .

Chapter 3: ActiveVOS Tutorial



	Table of Contents
	Preface 
	Chapter 1: Resources
	Process Developer Components
	Process Developer Feature Tour
	XML Syntax
	Tips and Tricks
	BPMN Design Hints
	Glossary

	Chapter 2: Introducing Business Process Execution Language
	BPEL for People Extension to WS-BPEL 2.0
	What is a BPEL Process
	BPEL Process Definition Elements
	Informatica Extensions to WS-BPEL 2.0

	Chapter 3: ActiveVOS Tutorial
	Part 1: Starting a New Process
	Step 1: Create the Tutorial Orchestration Project
	Step 2: Create a New Process File in the Tutorial/bpel Folder

	Part 2: Planning and Designing a Process
	Step 1: Create a Receive activity
	Step 2: Working with Layout Features in the Process Editor
	Step 3: Save the File and Review BPEL Validation Messages

	Part 3: Creating a Process Service Consumer Participant
	Step 1: Viewing the WSDL and Schema
	Step 2: Using the Participants View to Create a Process Service Consumer
	Part 4: Creating Partner Service Provider Activities
	Part 5: Adding Process Activities and Properties
	Part 6: Adding Fault Handling
	Part 7: Adding Compensation and Correlation
	Part 8: Simulating the Process
	Part 9: Deploying the Process
	Part 10: Creating a Form to Run the Process
	Part 11: Debugging Your Process Remotely
	Part 12: Using the Web Services Explorer to Start a Process



